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chapter 1

Introduction

This guide explains how to connect and config-
ure a Pro Tools or Media Station|PT workstation 
as an ISIS client within an Avid Unity ISIS sys-
tem, as well how to exchange audio and video 
media sequences between Pro Tools, 
Media Station|PT, and Avid application clients 
attached to an ISIS system.

This guide is written for Unity ISIS administra-
tors, Pro Tools users, and Avid users.

Avid Unity ISIS Capabilities
Avid Unity ISIS is an Ethernet-based shared stor-
age system that lets users of Pro Tools and Avid 
applications share the same media as follows:

• Stream audio and video media in real time.

• Configure up to nine users on the same ISIS 
system.

• Share AAF, OMF, and MXF audio and video 
sequences and media (DigiTranslator re-
quired).

• Share AAF, OMF, and MXF sequences using 
the Avid Interplay asset management system 
(Avid Interplay system required).

DigiTranslator 2.0
Use DigiTranslator 2.0 to convert AAF sequences 
into Pro Tools session files. You can also use it to 
export audio material from Pro Tools sessions to 
AAF sequences and files for import into other 
systems.

Avid Interplay
Avid Interplay with the Pro Tools Avid Interplay 
option lets users of Pro Tools, Media Station|PT, 
and Avid applications work within the same as-
set management system. 

For more information, refer to the Digi-
Translator 2.0 Guide.

Refer to the Pro Tools Avid Interplay Guide 
for detailed information.
Chapter 1: Introduction 1
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Overview of an ISIS System
This guide describes how to configure and work 
with a Pro Tools or Media Station|PT client 
within an Avid ISIS system. The ISIS installa-
tions addressed in this guide typically comprise 
the following components:

ISIS System Entire set of components within an 
individual ISIS installation.

ISS/Ethernet Switch Each ISIS crate has two 
built-in Ethernet connections known as ISS 
switches. You can also add external switches 
that connect to the built-in switches.

Avid Unity Transfer Engine (Optional) Server that 
lets Avid editing applications package elements 
of an Avid sequence and transfer them to other 
locations. You can add this as an additional cli-
ent, connected either directly or through a 
switch. 

System Director One or more servers (including 
a backup server) that functions as the heart of 
the Unity ISIS file system, by maintaining loca-
tion information for media stored on drives.

ISIS Crate Chassis that contains the drives that 
store the actual data.

Avid Interplay Transcode and/or Avid DMS ProEn-
code (Optional) Engine that distributes proces-
sor-intensive tasks to network servers in order to 
allow ISIS clients (such as Avid and Pro Tools 
workstations) to proceed without interruption.

Avid Interplay Access/Assist (Optional) Media 
asset management client application that en-
ables facility-wide searching, sorting, catalog-
ing, management, and retrieval of media.

Avid Interplay Engine (Optional) Server that man-
ages the metadata stored on the System Director 
server.

Clients One or more Avid, Pro Tools, or 
Media Station|PT workstations configured to be 
able to exchange data with other clients at-
tached to the ISIS system.

Avid Unity ISIS (Zone 1 system), with solid lines 
represent physical connections, while dotted lines 
represent connections through the switch

Avid Unity ISIS (Zone 2 system), with solid lines 
represent physical connections, while dotted lines 
represent connections through the switch
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AAF, OMF, and MXF Basics
AAF and OMF files are mechanisms for storing 
and retrieving media data and metadata so that 
projects can be freely exchanged between differ-
ent applications and platforms (such as between 
Pro Tools and Avid video editing applications).

Media data and metadata enable an application 
that receives AAF and OMF sequence files to au-
tomatically and quickly reassemble the compo-
sition. A simple metaphor for this approach is 
that media data files are the pieces of a puzzle 
and metadata is the set of instructions for as-
sembling the puzzle.

In the simplest case, only an AAF or OMF se-
quence is exchanged. If this sequence points to 
existing media files, the size of the sequence file 
is relatively small and the export/import process 
is relatively fast. 

AAF and OMF sequences can also have media 
data embedded in them. This creates a single, 
larger file that is slower to export and import, 
but which may be easier to manage than thou-
sands of files stored on different volumes. 

Pro Tools supports AAF and OMF sequences that 
contain embedded audio media. 

Pro Tools with DigiTranslator does not support 
AAF or OMF sequences containing embedded 
video media, except if you are importing such 
sequences into a video satellite track. In such 
cases, video metadata is imported into the track.

MXF

MXF is a media file format. There are MXF video 
files and MXF audio files, but there are no “MXF 
sequences.” An AAF sequence may refer to or in-
clude MXF media files, but OMF sequences can-
not refer to or include MXF files.

Avid Application Support for MXF Media

Media Station|PT supports MXF media as fol-
lows:

• Create MXF media when capturing, transcod-
ing, rendering, or using other methods to cre-
ate media.

• Import of MXF media files created in other 
Avid applications

• Export of MXF audio and video files

Pro Tools Support for MXF Media

Pro Tools supports MXF media as follows:

• Import of MXF video and audio media

• Export of MXF audio media

Pro Tools cannot export video files of any type.

Video files digitized in Pro Tools are technically 
of the MXF format, but are intended only for use 
in Pro Tools and are not tested for compatibility 
with other applications.

For the purposes of this user guide, AAF se-
quences are emphasized and referenced over 
the older OMF sequence standard.
Chapter 1: Introduction 3
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AAF

AAF sequences are the best way to exchange 
projects and maintain valuable metadata. An 
AAF sequence can refer to OMF and/or MXF me-
dia files, or have OMF and MXF media files em-
bedded within them. There is no such thing as 
an AAF audio or video media file. 

Avid Application Support for AAF 
Sequences

Media Station|PT supports AAF sequences as fol-
lows:

• Import and export of AAF sequences with em-
bedded video files (MXF or OMF) and/or au-
dio files (MXF, WAV, or AIFF).

• Import and export of AAF sequences that refer 
to external (linked) video files (MXF or OMF) 
and/or audio files (MXF, WAV, or AIFF)

Pro Tools Support for AAF Sequences

With DigiTranslator 2.0, Pro Tools supports AAF 
sequences as follows:

• Import and export of AAF sequences that con-
tain embedded or refer to external (linked) 
MXF, WAV, or AIFF audio files 

• Import of AAF sequences that refer to external 
(linked) MXF or OMF video files

• Video satellite systems only: Import of AAF se-
quences containing embedded video to a sat-
ellite track, in which case Pro Tools imports 
only the metadata (cuts and clip names) and 
not the video

Pro Tools does not export video files, tracks or 
metadata as part of AAF sequences.

OMF

OMF is both a media file and sequence format. 
OMF media files can be audio or video.

Avid Application Support for OMF Media 
and Sequences

Media Station|PT supports OMF media and se-
quences as follows:

• Import and export of OMF sequences with 
embedded OMF video files and WAV or AIFF 
audio files

• Import and export of OMF sequences that re-
fer to external (linked) OMF video files and 
WAV or AIFF audio files

Pro Tools Support for OMF Media and 
Sequences

With DigiTranslator 2.0, Pro Tools supports 
OMF media and sequences as follows:

• Import of OMF video files created by 
Media Station|PT or other Avid applications

• Export of OMF audio files

• Import and playback of OMF sequences that 
refer to external (linked) audio files or contain 
embedded audio files

• Import and playback of OMF sequences that 
refer to external (linked) OMF video files

• Export of OMF sequences that refer to exter-
nal (linked) audio files or contain embedded 
audio files

• Video satellite systems only: Import of OMF 
sequences containing embedded video to a 
satellite track, in which case Pro Tools imports 
only the metadata (cuts and clip names) and 
not the video

• Pro Tools does not export video files, tracks or 
metadata as part of OMF sequences.
Pro Tools Unity ISIS Guide



Embedded Media

Exporting to OMF or AAF with embedded media 
results in one large OMF or AAF file containing 
both the metadata and all associated media files. 
However, it is important to note that file size is 
limited to 2 GB.

Media Data (Media Files)

Media data represents raw audio or video mate-
rial and is stored in individual media files. Every 
time you record a piece of video or audio mate-
rial into an application, you are creating a media 
file containing media data. Audio media data is 
stored as samples (such as 44,100 or 48,000 sam-
ples per second of recording) while video media 
is typically stored as frames (24, 25, or 30 frames 
per second of recording).

The size of each media file depends on how 
much audio or video material it contains. For 
example, if you record ten minutes of continu-
ous video material at a high resolution, you 
might end up with a video media file that is 
1.8 GB in size, whereas a one minute recording 
at the same resolution might result in a 180 MB 
file. Media files tend to be large, since high qual-
ity audio and video signals are data intensive. 
Video data generally requires considerably more 
storage than audio data.

MXF Media Data Locations On the volumes you 
have designated for media storage, 
Media Station|PT stores all MXF media:

• When stored locally, MXF media is placed in 
the Avid MediaFiles/MXF/1 folder. 
Media Station|PT can also read MXF media lo-
cated at Avid MediaFiles/MXF/2, Avid Media-
Files/MXF/3, and so on.

• When stored in a shared environment, MXF 
media is placed in a folder called 
Avid MediaFiles/MXF/client.1 (where client rep-
resents the name of the client computer).

This guide refers to the root folder name (Avid 
MediaFiles) whenever referencing this folder.

OMF Media Data Locations On the volumes you 
have designated, Media Station|PT stores all 
OMF media in the OMFI MediaFiles folder.

Metadata

Metadata is used to describe:

• Information about each media file. This 
may include sample rate, bit depth, region 
names, the name of the videotape from 
which the media file was captured, and 
even time code values that specify where a 
file was used in a Pro Tools session.

• Information about Pro Tools sessions or 
other sequences, including what files are 
used, where they appear in a Timeline, and 
automation.

• For AAF or OMF sequences, metadata also 
includes information about unrendered 
AudioSuite effects (such as real-time EQ) on 
Avid workstations. Pro Tools skips unren-
dered effects on import. Rendered effects 
are media files, that can be imported or 
skipped on import into Pro Tools.

• For AAF or OMF sequences, information 
about automation (clip-based gain or key-
frame gain).

Embedded Media and Linked 
Media
There are two ways to handle media files when 
exporting AAF or OMF files: 

• Embedded media (in which the media files are 
embedded in an AAF or OMF sequence)

• Linked media (in which media files are refer-
enced by an AAF or OMF sequence)
Chapter 1: Introduction 5
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Pro Tools with DigiTranslator 2.0 lets you im-
port AAF or OMF sequences containing embed-
ded audio files. You can also import AAF or OMF 
sequences containing embedded video files, but 
only if you are importing them to a video satel-
lite track. In such a case, only the video meta-
data is imported.

Frame-Rate Accurate Video 
Editing and Sample-Rate 
Accurate Audio Editing
Avid applications edit with frame accuracy. This 
means that in a 30-fps project, you can edit at 30 
different locations for every one second of 
video. Pro Tools edits with sample rate accuracy. 
In a 48-kHz session, there are potentially 48000 
locations to edit for every second of audio. 

When Pro Tools exports an AAF composition 
destined for an Avid application, it must ensure 
that the audio files line up on frame boundaries. 
To do this, it might have to split an existing au-

dio region into three separate regions. For exam-
ple, the following illustration shows a 5-frame 
video clip and a corresponding audio region. In 
Pro Tools, the audio regions might not line up 
on video frame boundaries.

In order to export frame accurate audio regions, 
Pro Tools splits the audio media on frame 
boundaries and fills any gaps with silence. The 
following illustration shows the resulting audio 
regions that are exported to Avid.

When you use Export Selected Tracks as 
OMF/AFF to export tracks from Pro Tools with 
Enforce Avid Compatibility enabled, a number 
of additional media files labeled Sample Accu-
rate Edit appear in the Avid bins. These are the 
additional media files that Pro Tools creates to 
ensure that the Avid editing application receives 
frame-accurate audio. You also see the sample-
accurate edit media files if you zoom in on the 
imported audio in the Timeline.

Figure 1.  Original audio region

One Pro Tools audio region

5 frame video clip

The original audio region does not line up on video frame boundaries

Figure 2.  Exported audio region

Three exported audio regions

5 frame video clip

Exported audio regions line up on video frame boundaries

New audio region 
with padded silence

New audio region 
with padded silence
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System Requirements
Using Pro Tools or Media Station|PT within a 
Unity ISIS system requires the following;

• Windows XP or Mac OS X (Mac OS X sup-
ported only by Media Station|PT)

• Pro Tools HD

• An available expansion slot for a Gigabit 
Ethernet (Gig-E) based host bus adapter 
(HBA), and Gig-E Ethernet-based connectivity 
to the Avid Unity ISIS server

• ISIS client installation software

For complete system requirements, visit the 
Digidesign website (www.digidesign.com) and 
the Avid website (www.avid.com).

Compatibility Information

Digidesign can only assure compatibility and 
provide support for hardware and software it has 
tested and approved.

For a list of Digidesign-qualified computers, op-
erating systems, hard drives, and third-party de-
vices, visit the Digidesign website
(www.digidesign.com). 

For a list of Avid-qualified computers, operating 
systems, hard drives, and third-party devices, 
visit the Avid website (www.avid.com).

About Avid Unity ISIS Guides
PDF versions of Avid Read Mes are installed au-
tomatically with Avid Unity ISIS software. Also, 
searchable online help files containing the same 
information are accessible from the Help menus 
in the Interplay Access and Interplay Adminis-
trator applications.

You can use any of the following guides as sup-
plementary information for this guide:

• The Avid Unity ISIS System Setup Guide de-
scribes how to connect cables between com-
ponents that create a basic system and then 
how to connect more than one basic system 
together to create a larger, redundant system.

• The Avid Unity ISIS Client Manager User’s Guide 
provides information for the setup and instal-
lation of the ISIS Client Manager software and 
related hardware components. 

• The Avid Unity ISIS Site Preparation Guide con-
tains information that helps you prepare your 
site for installing ISIS system hardware. 

• The Avid Unity ISIS Administration Guide is in-
tended for system administrators responsible 
for the setup and day-to-day management of 
an Avid Unity ISIS media network, as well as 
for users who need to access workspaces on 
the network.

These guides and other ISIS guides are available 
on the Avid ISIS Online Library DVD and on the 
Avid Knowledge Base, located at this link: 
http://www.avid.com/onlinesupport. To view 
or print PDF guides, you can use Adobe Reader.
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About the Pro Tools Avid Interplay 
Guide

The Pro Tools Avid Interplay Guide describes how 
to set up Pro Tools as a client within an Avid In-
terplay system, as well as use Pro Tools and In-
terplay to exchange sequences between Avid 
and Pro Tools users.

Support for Avid Unity ISIS
For support on Avid Unity ISIS, visit Avid’s on-
line Knowledge Base (located at this link: 
www.avid.com/onlinesupport). Online services 
are available 24 hours per day, 7 days per week. 
Search this online Knowledge Base to find an-
swers, to view error messages, to access trouble-
shooting tips, to download updates, and to read 
or join online message-board discussions.

For support on Pro Tools HD, see “About 
www.digidesign.com” on page 9.

Conventions Used in This 
Guide
All Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:
:

The following symbols are used to highlight im-
portant information:

Convention Action

File > Save Choose Save from the 
File menu

Control+N Hold down the Control 
key and press the N key

Control-click Hold down the Control 
key and click the mouse 
button

Right-click Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your Pro Tools system.

Important Notices include information that 
could affect your Pro Tools session data or 
the performance of your Pro Tools system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
this guide or other Pro Tools Guides.
Pro Tools Unity ISIS Guide



About www.digidesign.com
The Digidesign website (www.digidesign.com) is 
your best online source for information to help 
you get the most out of your Pro Tools systems. 
The following are just a few of the services and 
features available. 

Support Contact Digidesign Technical Support 
or Customer Service; download software up-
dates and the latest online manuals; browse the 
compatibility information for system require-
ments; search the online Answerbase or join the 
worldwide Pro Tools community on the Digide-
sign User Conference.

Training and Education Study on your own using 
courses available online or find out how you can 
learn in a classroom setting at a certified 
Pro Tools training center. 

Products and Developers Learn about Digidesign 
products; download demo software or learn 
about our Development Partners and their plug-
ins, applications, and hardware. 

News and Events Get the latest news from 
Digidesign or sign up for a Pro Tools demo.

To learn more about these and other resources 
available from Digidesign, visit the Digidesign 
website (www.digidesign.com). 
Chapter 1: Introduction 9
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chapter 2

Configuring a Workstation as an ISIS Client

This chapter describes how to install and config-
ure an individual Pro Tools or Media Station|PT 
workstation as a client of an Avid Unity ISIS sys-
tem.

Installation Overview
Installing the hardware and software involves 
the following process:

1  Make sure the software (Media Station|PT or 
Pro Tools) is installed on the workstation.

2  Install the ISIS client hardware.

3  Configure the Windows XP Firewall.

4  Install the ISIS client software for Zone 1 or 
Zone 2 clients.

Workstation Configuration 
Requirements
Before configuring a workstation as a client of 
an ISIS system, obtain from your Unity adminis-
trator (and make a note of) the following param-
eters for the ISIS system to which you are con-
necting your clients: 

• IP address

• Subnet Mask

• Default Gateway

Installing Media Station|PT or 
Pro Tools
If you are configuring a Media Station|PT work-
station as an ISIS client, ensure that 
Media Station|PT and any optional hardware 
(such as Avid video peripherals) have been prop-
erly installed. For detailed information, see the 
Media Station|PT Guide.

If you are configuring a Pro Tools workstation as 
an ISIS client, ensure that Pro Tools hardware 
and software are properly installed. For detailed 
information, see the Pro Tools HD Getting Started 
Guide.
Chapter 2: Configuring a Workstation as an ISIS Client 11
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Avid Unity ISIS Client and 
Zone Descriptions
All clients in the system are classified by zones, 
depending on how they connect to the network. 
The following list defines the clients in each net-
work layer by its zone classification:

Zone 1 Client Connected to ISIS VLANs via an 
ISS 1 Gb port (direct connection)

Zone 2 Client Connected to ISIS VLANs via a 
1 Gb port on an Avid qualified layer-3 switch 
(non-routed)

Installing the ISIS Client 
Hardware
The Intel PRO⁄1000 MT Ethernet card is re-
quired for Pro Tools and Media Station|PT con-
nections to an Avid Unity ISIS system. For the 
latest supported version for your system, search 
the online Knowledge Base at the following link:
www.avid.com/onlinesupport. 

Installing the hardware and software for the 
Intel PRO⁄1000 MT Ethernet card requires the 
following steps:

1  Insert the Intel PRO⁄1000 MT card into your 
workstation and connect it to an ISS switch.

2  Install the Intel PRO/1000 MT driver.

Inserting the Intel PRO⁄1000 MT 
Ethernet Card into a Workstation

The Avid Unity ISIS client hardware consists of 
one Ethernet cable (rated CAT 5e or higher) and 
a single qualified Ethernet HBA (Host Bus 
Adapter), such as the Gig-E Intel PRO⁄1000 MT. 

You must purchase Ethernet cables separately.

To insert the HBA Ethernet card into a Pro Tools or 
Media Station|PT workstation:

1  Shut down and power off your computer and 
expansion chassis (if one is present). 

2  Open your computer according to the instruc-
tions included with it. 

3  Release any static electricity by touching the 
power supply, or another grounded item.

4  Remove the Ethernet card from the antistatic 
bag, being careful to handle it only by the edges.

5  Determine the correct PCI/PCIe card slot order 
(see Appendix A, “PCI and PCIe Slot Configura-
tions for Pro Tools and Media Station|PT with 
Avid Unity ISIS Systems”).

6  Line up the Ethernet card with the installation 
slot, and slide the card into place gently so the 
PCI/PCIe connector is aligned with the correct 
PCI/PCIe slot.

7  Press down firmly on the card with even pres-
sure. The connector should click into place in 
the PCI/PCIe slot.

8  To attach the card bracket to the computer 
mounting bracket, fasten the card in place using 
a screw or latch down the securing bracket if one 
is built in.

Clients can run in any lower-numbered 
zone. For example, a Zone 2 client can also 
run in as a Zone 1 client.

For a complete list of qualified host bus 
adapters please consult Avid support.
Pro Tools Unity ISIS Guide
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To connect an installed Intel PRO⁄1000 MT card 
to the ISS (ISIS switch):

1  Plug one end of an Ethernet cable into the 
Intel PRO⁄1000 MT card’s Ethernet port. 

2  Connect the other end of the Ethernet cable 
to the ISS (ISIS Switch).

Installing the Intel PRO⁄1000 MT 
Driver

Once the Intel PRO⁄1000 MT Ethernet card is 
physically installed in your computer, you must 
install the appropriate driver. 

If your system has a DVD drive, you can install it 
directly from the Avid Unity ISIS DVD. If you do 
not have a DVD drive, you need to use another 
means (such as a network connection) to trans-
fer the necessary driver from the Avid Unity ISIS 
DVD to your system.

To install the Intel PRO⁄1000 MT driver:

1  If you did not restart the system after install-
ing Intel PRO⁄1000 MT Ethernet card, do so 
now.

After you restart your system, the following mes-
sage appears: “Looking for the Intel PRO/1000 
MT driver.” 

2  Cancel the message.

3  Insert the DVD into the DVD drive.

4  On the DVD, navigate to the following folder: 
Tools_and_Thirdparty_Software/
Drivers_and_Firmware.

5  In the Drivers_and_Firmware folder, copy the 
Intel_MT_Server_NIC folder to the desktop of 
your system.

6  Navigate to the Intel_MT_Server_NIC folder 
on your desktop, and go to Driver/Intel NIC 
10.0 Avid.

7  Double click the Auto-run.exe file.

An Installer window opens.

8  Click Install Drivers.

A message window appears stating that the driv-
ers and other files that are needed are being in-
stalled. This may take some time to complete. 
When the message window closes, the installa-
tion is complete.

Setting the IP Address of the 
Intel PRO⁄1000 MT Card

After installing the Intel PRO/1000 MT Ethernet 
card and connecting it to the appropriate ISIS 
switch, you must set the IP address, subnet 
mask, and default gateway of the Ethernet card. 
These settings match those of the ISS (ISIS 
Switch) to which the card is connected.

Before adding these settings, obtain the follow-
ing information regarding the ISS Switch to 
which you connected the Ethernet card:

• IP Address

• Subnet Mask

• Default Gateway

See your ISIS administrator for details.

For more information, see the Avid Unity 
ISIS Client Setup and Installation Guide.
Chapter 2: Configuring a Workstation as an ISIS Client 13
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To set the IP address of the Intel PRO⁄1000 MT 
card:

1  Click the Start menu.

2  Right-click My Network Places, and choose 
Properties.

3  In the Network Connections window, right-
click the item that represents the Ethernet port 
that is physically connected to the Ethernet ca-
ble, and choose Properties.

4  In the Connections Properties dialog, select 
the Internet Protocol (TCP/IP) option (you may 
have to scroll down), and click Properties.

5  In the Internet Protocol (TCP/IP) Properties 
dialog, select Use the Following IP Address.

6  Type the following information:

• IP Address

• Subnet Mask

• Default Gateway

Choosing Properties from My Network Places

Choosing Properties from Network Connections

Connection Properties dialog

Connection Properties dialog
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7  Click OK.

8  In the Connections Properties dialog, click 
OK.

9  Close the Network Connections window.

Connecting an Intel PRO⁄1000 MT 
Ethernet Card to an Avid Unity ISIS 
System

The Intel PRO⁄1000 MT Ethernet card is a dual 
port card that allows you to use dual-attached 
redundancy for the client. (You can also config-
ure your network as a single-connect system.) 

Figure 3 shows a sample system connected in 
Zone 1 and Zone 2 configurations and the on-
board Ethernet connection that is physically 
connected to the corporate network. 

Pro Tools and Media Station|PT clients are 
not supported in a Zone 3 environment.

Figure 3.  Connecting an Intel PRO⁄1000 MT Ethernet card to an Avid Unity ISIS system
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Configuring the Windows XP 
Firewall
If you install Service Pack 2 on your 
Windows XP system, the Windows Firewall is 
set by default. The Windows Firewall is part of 
the Security Center located in the Windows XP 
Control Panel, but it is possible to have errors if 
the firewall is enabled and the Don’t Allow Ex-
ceptions option is selected on the General tab of 
the Windows Firewall dialog box. 

To make sure that the settings are correct when 
the firewall is enabled:

1  Choose Start > All Programs > Accessories > 
System Tools > Security Center.

The Windows Security Center window opens.

2  Click Windows Firewall. 

3  In the Windows Firewall dialog, click the Gen-
eral tab, and select On (recommended). You can 
select Off (not recommended) if you do not 
want to enable the firewall.

4  Deselect the Don’t Allow Exceptions option.

5  Click OK.

6  In the Windows Security Center window, click 
Automatic Updates.

7  In the Automatic Updates dialog box, select 
the Turn off Automatic Updates option.

8  Click OK.

9  Close the Windows Security Center window.

Installing Client Software for 
Zone 1 and Zone 2 Clients
Installing client software on a client allows the 
client interact with the ISIS system.

You can install the client software from the fol-
lowing sources:

Browser Use a web browser to reach the Admin-
istration Tool and install it from the System Di-
rector because it was installed during the previ-
ous installation of the Client Installers. This is 
the easiest and recommended option.

DVD Install the software on each individual cli-
ent from the DVD installer disc.

Network Store the client software somewhere on 
a network and allow everyone who needs the 
software to gain access to it and install it.

When connecting Avid Unity ISIS clients, keep 
the following points in mind:

• When installing Avid Unity ISIS client soft-
ware on Windows systems, make sure you are 
up-to-date with your Windows critical up-
dates.

• Zone 1 clients must use 1 Gb connections to 
the ISS. The ISS does not negotiate at any rate 
below 1 Gb. If 100 BASE-T connections are 
needed, connect the clients or server to exter-
nal switches that are configured for Zone 2.
Pro Tools Unity ISIS Guide



Installing the ISIS Client Software 
Using a Browser

Before installing ISIS client software using a 
browser, make sure you have the IP address of 
the ISIS System Director (available from your 
ISIS administrator).

To install the client software using a browser:

1  Start your browser application.

2  Launch Windows Update and accept all 
“High-priority Updates.”

3  In the browser, navigate to the following URL:
https://[System Director IP address (or virtual 
name)]:5015.

4  In the System Administration Tool, type your 
Administrator’s password.

5  Click Administration.

An Installer Downloads screen opens.

6  Click the appropriate Flash executable.

7  Click Win32Client.

During the client software installation, a dialog 
box appears asking if you need the Compatibil-
ity drive loaded. 

8  Do one of the following:

• If the version of the Avid editing applica-
tion you are using is listed, select Yes. 

• If you are installing on a Pro Tools client or 
your Avid editing version is not listed, se-
lect No.

The installer begins installing the software.

9  When the installer asks who the software is 
for, select the Everyone option.

10  When prompted, restart the computer.

The client software is installed.

ISIS software installer downloads page

Installers
Chapter 2: Configuring a Workstation as an ISIS Client 17
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chapter 3

Using a Client in an ISIS System

This chapter describes setup instructions and 
configuration parameters for each workstation 
you add as an ISIS client.

About Avid Unity ISIS Client 
Manager
Avid Unity ISIS Client Manager allows your cli-
ent to connect to the Avid Unity ISIS system. 
Once installed, the Client Manager runs in the 
background so you can mount and access your 
workspaces at any time, as well as manage your 
workspaces and bandwidth reservations. 

Client Manager displays an icon in the Win-
dows Taskbar. When logged in, the Client Man-
ager displays all available System Directors and 
all available workspaces.

The Client Manager allows users with the neces-
sary account privileges to resize workspaces, to 
protect and unprotect workspaces, and to spec-
ify client bandwidth reservations, if any.

Connecting to the Avid Unity 
ISIS System
The Client Manager automatically checks for all 
System Directors available in the Avid Unity ISIS 
system. You can use the Client Manager to con-
nect to the network and optionally reconnect 
automatically when you reboot your system. 
Chapter 3: Using a Client in an ISIS System 19
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Opening the Client Manager

To connect to the Avid Unity ISIS network via the 
Client Manager:

1  Do one of the following:

• If the Client Manager icon is not available 
in the Windows Taskbar, choose Start > All 
Programs > Avid Unity ISIS > 
Client Manager.

• Click the Client Manager icon in the Win-
dows Taskbar.

• Right-click the Client Manager icon and se-
lect Unity ISIS Client Manager.

2  In the Avid Unity ISIS Client Manager, click 
Connections.

The Connections list displays all available Sys-
tem Directors.

3  Select the System Director you want to con-
nect to from the Connections list.

4  Select the System Director you want to con-
nect to from the Connections list.

5  If you want to connect to the ISIS system with 
a username and password different from those 
for your client system, do the following:

• Click the Username menu, and select 
Other.

• Type your Avid Unity ISIS account name in 
the Username field.

• Type your password in the Password field.

Client Manager icon and pop-up menu

Client Manager window

Client Manager icon

You can sort the Connections list by clicking 
the Sort menu and selecting Hostname or 
Connection Status. 
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6  Do one of the following:

• Click the Connect button.

• Click the Fast menu, and select Connect.

The Connect button changes to green when the 
connection is complete.

7  If you use the same username and password 
for your client system and your Avid Unity ac-
count, and you want to connect to the network 
automatically every time you start your system, 
click the Auto Connect button. The Auto Con-
nect button changes to blue.

Changing Your Password

You can use the Client Manager to change the 
password you use to log on to your Avid Unity 
ISIS user account.

To change your Avid Unity ISIS account password:

1  Open the Client Manager (see “Connecting to 
the Avid Unity ISIS System” on page 19).

2  In the Menu panel, click Connections.

3  In the Connections list, select a user.

4  Click the Fast menu, and select Change User 
Password.

5  In the Changing Password dialog, do the fol-
lowing:

• Type your existing password in the Old 
Password field.

• Type your new password in the New Pass-
word field.

• Type the new password a second time in 
the Confirm New Password field.

6  Click OK.

Accessing Client Manager Help

The Client Manager Help provides background 
information for tasks, windows, and dialog 
boxes. The Help system is HTML-based and op-
erates in your default Web browser.

To open the Client Manager help:

In the Menu panel, click Help.

Client Manager 

If your username and password are different 
for your client system and your Avid Unity 
account, your system cannot automatically 
reconnect to the ISIS system when you re-
start your system.

Fast menu

Auto-Connect 
button

Connect
button

Change Password dialog
Chapter 3: Using a Client in an ISIS System 21



22
Mounting and Unmounting 
Workspaces
If your system is connected to an Avid Unity 
ISIS system, use the Client Manager to mount a 
workspace before you begin your work session. 

When one or more workspaces are mounted and 
the connection to the System Director is subse-
quently lost, a message in the Taskbar indicates 
the workspace is unavailable.

The Client Manager then automatically at-
tempts to reestablish the connection with the 
System Director. When the connection is suc-
cessfully reestablished, a message in the Taskbar 
informs you of the connection state.

To mount Avid Unity ISIS workspaces on your 
system:

1  Open the Client Manager (see “Connecting to 
the Avid Unity ISIS System” on page 19).

2  In the Menu panel, click Workspaces.

The Workspaces list opens. The Mount button 
appears green for workspaces that are already 
mounted. 

3  In the Workspaces list, select the workspace 
you want to mount.

Your Avid Unity user account must have ac-
cess to at least one workspace. For informa-
tion on workspace access, see “Creating Cli-
ent Accounts for Users” in the Avid Unity 
ISIS Administration Guide.

Client Manager (displaying Workspaces)

You can sort the Workspaces list by clicking 
the Sort menu and selecting the appropriate 
name, capacity, or status. You can also fil-
ter the list by Workspace or System Director 
name. For more information, see “Sorting 
and Filtering the Display” on page 26.
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4  Do one of the following:

• Click the Mount button.

• Click the Fast menu, and select Mount.

The Client Manager mounts the selected work-
space on your client and the Mount button 
changes to green. The Workspaces list displays 
the drive the workspace is mounted to. If you 
use letterless drive mappings, the Workspaces 
list displays “UNC” next to the workspace.

5  If you want the selected workspaces re-
mounted the next time you log in, do one of the 
following:

• Click the Auto Mount button.

• Click the Fast menu, and select Auto 
Mount On.

The Auto Mount button changes to blue.

To unmount Avid Unity ISIS workspaces on your 
system:

1  Make sure that neither Pro Tools or 
Media Station|PT is running.

2  In the Workspaces list, select the workspace 
you want to unmount.

3  Do one of the following:

• Click the Mount button to deselect it.

• Click the Fast menu, and select Unmount.

The Client Manager unmounts the workspace 
from your client, and the Mount button 
changes to gray.

Using the Workspace Display

The Workspaces list provides basic information 
about each mounted workspace, including the 
following:

• All available workspaces

• System Director name

• Workspace name

• Drive letter for the mounted workspace

• Connection status (connected, unconnected, 
or automounted)

• Used space (as a percentage of available capac-
ity)

• User privileges for the workspace (read, 
read/write) 

• Free space (in gigabytes)

• Protection status (protected when the Protec-
tion icon is present; unprotected when the 
Protection icon is not present)

• Workspace capacity (in gigabytes)

• System capacity (in terabytes)

Client Manager (displaying Workspaces)

Fast menu

Auto-Connect 
button

Connect
button
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Sorting and Filtering the Display

If the Workspaces list contains a large number of 
workspaces, you might want to sort or filter the 
items in the list for easier managing.

To sort the Workspaces list:

Click the Sort menu and select one of the fol-
lowing:

• System Director Name

• Workspace Name

• Mount Status

• Automount Status

• User access

• Protect Status

• Used Space

• Free Space

The Workspaces list updates to reflect the sort-
ing parameter.

Configuring Workspace Drive 
Letter Assignments

The Client Manager allows you to configure the 
drive letter used when mounting Avid Unity 
ISIS workspaces. This allows you to prevent 
workspaces from being assigned drive letters 
you want reserved for other uses.

If your system requires using Universal Naming 
Convention (UNC) paths for all mounted work-
spaces rather than drive letters, you can use Cli-
ent Manager to set this as the default mapping 
for workspaces.

Figure 4.  Client Manager (Workspace display)
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The Client Manager skips fixed drives and 
drive letters that are already in use.
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To configure the drive letter for mounting 
workspaces:

1  Open the Client Manager (see “Connecting to 
the Avid Unity ISIS System” on page 19).

2  In the Menu panel, click Workspaces.

3  Click the Fast menu, and select Mount To.

4  In the Mount To dialog, click the Choose drive 
letter menu, and select the drive letter you want 
to use for mounting workspaces.

5  Click OK.

Testing Your Avid Unity ISIS 
Connection
Before you begin using the Avid Unity ISIS sys-
tem, you should test the connection to your 
workspace to make sure communication be-
tween your client system and the ISIS system is 
sufficient for the functionality needed by your 
system. You can use the Avid PathDiag tool, 
which installs with your client software, to test 
the read/write throughput (the rate that read 
and write operations are conducted between 
your client system and a mounted workspace).

Starting the Avid PathDiag Tool

The Avid PathDiag tool is a diagnostic utility 
that allows you to validate your Avid Unity ISIS 
connection by quantifying the throughput of 
Windows editing applications accessing 
Avid Unity ISIS workspaces.

To start Avid PathDiag tool:

Choose Start > All Programs > Avid Unity 
ISIS > PathDiag.

Setting Up a Test

To test the general status of your connection to 
the ISIS system, you need to configure a custom 
test.

To access the custom test settings options:

1  Start the PathDiag tool (see “Starting the Avid 
PathDiag Tool” on page 25).

2  Click the Setup button.

Mount To dialog

If you are using Media Station|PT and want 
to use a Universal Naming Convention path 
for the workspace instead of a drive letter, 
select UNC (letterless). (Pro Tools does not 
support UNC paths for access to media 
files.)

For detailed information on the PathDiag 
tool, see the Avid Unity ISIS Client Manager 
User’s Guide.

PathDiag tool
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3  In the PathDiag tool Settings dialog, click Cus-
tom Test.

The dialog box expands to display the Custom 
Test Settings area.

4  In the Custom Test Settings area, adjust the 
custom test parameters as follows:

Path to Test Select a drive with a mapped 
Avid Unity ISIS workspace

Duration (Minutes) Select 2.

Loop Select this option if you want the test to re-
peat the test indefinitely after its duration is 
complete.

File Access Method Select Automatically select.

Reads vs. Writes Select Writes, then Reads (Se-
quential).

Transfer Size (KB) Select 4096 for an Avid edit-
ing application (such as Avid Media Composer 
or Media Station|PT) or Pro Tools using video. 
Select 1024 for other Avid applications or 
Pro Tools using audio only.

Transfer Rate (KB/S) Select Unlimited.

Max File Size (MB) Select 100.

5  Click OK.

Running the Test

You can start and stop the currently configured 
test using the Start and Stop buttons.

To start the currently configured test:

Click Start in the PathDiag tool main window.

The test runs for the specified duration and then 
stops automatically. The elapsed time a test has 
been running and the remaining time are dis-
played in the Control area.

The following list indicate the results that reflect 
an optimal connection for an Avid 
Media Station|PT client on the ISIS system:

• Average Read: 60–70 MB/seconds

• Average Write: 70–80 MB/seconds

• Peak Read: less than 5 MS/100

• Peak Write: less than 5 MS/100

In addition, results should plot along a smooth, 
stable line in the Test Results graph, and they 
should not have peaks or spikes that indicate 
variable performance within the ISIS system.

PathDiag tool Settings dialog

PathDiag tool Settings dialog (Custom Area)

These results primarily reflect video perfor-
mance verification for Media Station|PT, 
and not Pro Tools.
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In Figure 5, which shows a healthy read/write 
test, the test loops so that the Read results and 
Write results fall to zero as the test alternates be-
tween Reads and Writes. However, Reads and 
Writes plot consistently in the Test Results 
graph and appear level over the course of the 
test.

In Figure 6, which shows problems in the con-
nection to the workspace, the average Read level 
and Recent Read level display fluctuations. The 
Peak Read should be lower and plot along a flat 
line in the graph. Also, the average Read level is 
higher than the average Write level, which 
might indicate that the workspace is unmirrored 
(that is, it is not a protected workspace).

These results represent guidelines for Avid-qual-
ified systems; performance on your system 
might vary. If your Read/Write results differ 
from those listed here by more than 5–10 MB/s, 
see your Avid Unity ISIS administrator.

Adjusting Workspace Size
You can use the Client Manager to resize work-
spaces if your user account on the Avid Unity 
ISIS system has the necessary privileges.

To adjust the size of a workspace:

1  Open the Client Manager (see “Connecting to 
the Avid Unity ISIS System” on page 19).

2  In the Menu panel, click Workspaces.

3  In the Workspaces list, expand the display for 
a selected workspace.

4  Click the handle of the Workspaces Size 
graph, and drag it to resize the graphical display. 
The workspace size listed in the Capacity text 
box and the Free space size update as you drag 
the handle.

Figure 5.  PathDiag tool Settings dialog (Healthy 
read/write test)

Figure 6.  PathDiag tool Settings dialog (Healthy 
read/write test)

Do not adjust workspaces while clients are 
writing files to them.

You cannot reduce workspace size below the 
storage space listed as the Used space size 
above the Capacity text box, which indi-
cates the amount already allocated to files. 
(For empty workspaces, the minimum work-
space size is 1 GB.) You also cannot in-
crease workspace size above the storage 
space listed as the maximum size.
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Protecting and Unprotecting 
Workspaces
You can use the Client Manager to enable or dis-
able workspace protection if your user account 
on the Avid Unity ISIS system has the necessary 
privileges.

To enable or disable workspace protection:

1  Open the Client Manager (see “Connecting to 
the Avid Unity ISIS System” on page 19).

2  In the Menu panel, click Workspaces.

3  In the Workspaces list, expand the display for 
a selected workspace.

Figure 7.  Client Manager (Workspace size adjustments)
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When you modify the protection status of a 
workspace, the ISIS system performs a redis-
tribution of any data on the storage ele-
ments in the workspace.
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4  Click the Fast menu, and select Enable Protec-
tion or Disable Protection.

The Protection icon is present when the work-
space is protected and is not present when it is 
not protected.

Setting Bandwidth 
Reservations
You can use the Client Manager to obtain a de-
fault bandwidth reservation; however, the reser-
vation cannot exceed your system’s device limit 
or your client bandwidth limit, whichever is 
lower. The Avid Unity ISIS system enforces an 
effective bandwidth limit based on either the 
client type specified by the Client Manager or 

the reserved bandwidth value set in the Admin-
istration tool. Your Avid Unity ISIS administra-
tor sets the bandwidth limits, and the band-
width limit is listed in the Workspaces list. 

To set a bandwidth reservation:

1  Open the Client Manager (see “Connecting to 
the Avid Unity ISIS System” on page 19).

2  Click Bandwidth.

Figure 8.  Client Manager
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Setting a bandwidth limit on editing clients 
can adversely affect playback performance. 
Avid recommends that you do not set band-
width limits for Media Station|PT users 
(other than Avid AirSpeed® clients). How-
ever, your administrator might need to set a 
bandwidth limit for other devices, such as 
an Avid Unity TransferManager, in the 
event the device is consuming more band-
width than expected.
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3  In the Users list, expand the display for a se-
lected user.

4  Select the number of media streams for which 
you want to reserve bandwidth from the 
Streams menu.

5  Click the Resolution menu, and select a reser-
vation for your project.

6  Click Accept.

7  Click the Reserve button.

8  If you want to reserve bandwidth automati-
cally each time you log on to the ISIS system, do 
one of the following:

• Click the Reconnect button.

• Click the Fast menu, and select Auto Re-
serve On.

Performing Administrative 
Tasks
You can use the Preferences dialog box and the 
Messages dialog box to manage the following 
administrative tasks:

• Set display properties

• Clear cached information

• View, save, and clear logged error messages

Setting Display Properties in the 
Client Manager

Display properties in the Client Manager con-
trol how the application displays information 
on your local system.

To set Client Manager display properties:

1  Open the Client Manager (see “Connecting to 
the Avid Unity ISIS System” on page 19).

2  Click Preferences.

Figure 9.  Client Manager (setting bandwidth resolutions)
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3  In the Preferences dialog, click General.

4  In the General area, select the appropriate op-
tions:

Start Client Manager Hidden Select this option to 
allow the Client Manager to run hidden and ac-
cessible from the Client Manager icon in the 
Taskbar. Deselect this option to open the Client 
Manager each time you start your system.

Use UNC (Letterless) Drive Mappings Select this 
option to use UNC paths to map workspaces in-
stead of drive letters.

Enable Bandwidth Dialog Select this option to 
enable the “Display Bandwidth in Bits Per Sec-
ond” option as well as the bandwidth displays 
in Client Manager tool.

Display Bandwidth in Bits Per Second Select this 
option to display bandwidth in bits per second. 
Deselect this option to display bandwidth in 
bytes per second.

Measure Free Space In You can choose to dis-
play the amount of available space in your work-
space either in gigabytes (GB) or in the total 
length of stored media (hours:minutes:seconds) at 
a selected resolution.

5  Click Apply.

6  Click Close.

Clearing Cached Data

The Client Manager maintains information on 
site settings in cache files, and the tool appends 
data each time you open the Client Manager. 
You can clear the cached information—for ex-
ample, to remove settings for users no longer 
working on a specific system—by deleting the 
cache files.

To clear cached data:

1  Open the Client Manager (see “Connecting to 
the Avid Unity ISIS System” on page 19).

2  Click Preferences.

3  In the Preferences dialog, click Advanced.

Client Manager Preferences dialog

Pro Tools does not support UNC paths for 
access to media files.

Client Manager Preferences dialog
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4  Do one of the following:

• Click the Clear button for each cache file 
you want to clear.

• Click the Clear All button to clear all 
cached data.

5  Click Apply.

6  Click Close.

Using Logs and Messages

The Client Manager keeps an log of events, in-
formation, and error messages. You can view the 
current log in the Messages dialog box. You can 
also save a copy of the log, and you can clear the 
log maintained for the current work session.

To view Client Manager event logs:

1  Open the Client Manager (see “Connecting to 
the Avid Unity ISIS System” on page 19).

2  Click Messages.

The Messages dialog box opens and displays all 
event messages. You can sort the Messages list 
by clicking the Sort menu and selecting Level, 
Time, or Message.

To save a copy of the event log:

1  Click the Fast menu, and select Export.

The Export dialog box opens.

2  Navigate to the folder where you want to save 
your log.

3  Type a name for the log in the File Name text 
box.

4  Click Save.

The Client Manager saves the event messages as 
a log file (filename.log).

To clear all event logs:

Click the Fast menu, and select Clear.

Configuring the Pro Tools|HD 
Playback Engine
Pro Tools|HD workstations have multiple play-
back modes at different sample rates. For opti-
mum performance in an ISIS system, it is recom-
mended that you use the least number of voices 
per DSP. 

To configure the Playback Engine:

1  Launch Pro Tools.

2  Choose Setups > Playback Engine. 

The Client Manager clears all logs when you 
exit the application.

Client Manager Preferences dialog Playback Engine dialog for Pro Tools|HD
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3  From the Number of Voices pop-up menu, se-
lect the lowest number of voices per DSP for the 
Playback Engine.

4  Click OK.

Configuring Pro Tools Session 
Settings for a New Session
The following describes the recommended ses-
sion settings for creating a new Pro Tools session 
when working in an ISIS system.

To create a new Pro Tools session for Avid Unity 
ISIS:

1  In Pro Tools, choose File > New Session.

2  In the New Session dialog, select an Audio File 
Type for the session that is compatible across all 
workstations.

3  Select a Sample Rate for the session that is 
compatible across all workstations.

4  Select a Bit Depth for the session that is com-
patible across all workstations.

5  Name the session and save it to an Avid Unity 
ISIS workspace.

Audio File Type

Pro Tools supports AIFF and BWF (.WAV) audio 
files natively. 

For the best media compatibility between 
Pro Tools workstations and Avid workstations, 
you should choose to work with Broadcast WAV 
media files. Make sure the Audio File Type pop-
up menu in the New Session dialog box is set to 
WAV when you are creating a new session.

Sample Rate

Pro Tools HD supports sample rates up to 
192 kHz, but other Pro Tools and Avid worksta-
tions only support lower sample rates. There-
fore, when working on an Avid ISIS network, it 
is vital to use sample rates for shared media that 
are supported on all workstations.

It is preferable for all participants in the system 
to agree on a standard, universal sample rate for 
the sake of compatibility and to avoid media 
conversion. Many facilities choose 48 kHz, 
which is the industry standard for post produc-
tion and broadcast applications. 

You can use the other Playback Engine set-
tings if your session’s audio media files are 
on local storage. 

New Session dialog

All Sound Designer II files must be con-
verted to a Windows-compatible format for 
use in an ISIS system.

The WAV file format is required when 
working with audio files containing field re-
corder metadata.
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Bit Depth

Some older Avid workstations support only 
16-bit audio. Make sure you consider the follow-
ing when you are starting a new audio session:

• For maximum compatibility when using a 
Pro Tools workstation to share audio files and 
sequences with older Avid workstations in an 
ISIS system, set the bit depth to 16-bit in the 
New Session dialog box when you are creating 
new session files. 

• When using a Pro Tools workstation to share 
audio files and sequences with either 
Pro Tools workstations or current Avid work-
stations in an ISIS system, set the bit depth to 
either 16-bit or 24-bit (depending on your 
project requirements) in the New Session dia-
log box when you are creating new session 
files.

ISIS Client Performance and 
Guidelines
Avid and Digidesign have tested Pro Tools and 
Media Station|PT client performance in an ISIS 
environment using a single ISIS engine contain-
ing 16 storage blades grouped as a single storage 
group. Additional configurations have not been 
tested at this time.

An individual ISIS engine containing 16 storage 
blades organized as one storage group can serve 
the following clients simultaneously:

• Up to nine Pro Tools workstations, each of 
which contains:

• Up to forty-eight audio tracks with 48 kHz 
24-bit audio

• One DV25 or DV50 video stream

– and –

• Up to two Media Station|PT workstations, 
each of which contains up to two DV25 or 
DV50 video streams

Compatibility and Performance

Actual performance depends on specific config-
uration and program material. More configura-
tions will be announced as they are tested. For 
the latest information, see the Avid Unity ISIS 
compatibility pages on the Digidesign website
(www.digidesign.com).

For the most current compatibility informa-
tion on supported Pro Tools systems and 
Avid Unity ISIS, refer to the Avid website 
(www.avid.com) and the Digidesign web-
site (www.digidesign.com).
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Determining Total Throughput

Each ISIS engine within an ISIS environment 
comprises sixteen ISIS storage blades which, 
when organized into a single storage group, can 
produce upwards of 240 or 300 MB/second of 
aggregate bandwidth throughput.

The total bandwidth throughput within an ISIS 
environment is based on the number of ISIS en-
gines connected to your system. Each client you 
attach to the ISIS engine uses a certain amount 
of that bandwidth depending on the type of me-
dia being played back.

Total ISIS Engine Bandwidth 
Throughput

The following table shows the amount of avail-
able throughput offered by a single ISIS engine 
grouped as one storage group.

While it is possible to create multiple storage 
groups by grouping four or more storage blades, 
the total throughput is lowered depending on 
the number of storage blades in that storage 
group. 

Estimated Client Bandwidth Usage

The following table shows the estimated 
amount of bandwidth usage based on the type 
of media streaming from a single ISIS engine 
grouped as one storage group.

Media Station|PT Client Performance

The following resolutions for Media Station|PT 
have been tested and are supported on Avid 
Unity ISIS media networks in both NTSC and 
PAL. As enhancements to Avid Unity ISIS soft-
ware occur the number of resolutions will in-
crease:

• 2:1

• 3:1

• 15:1

• 20:1

• MPEG–2 Proxy for InterPlay

• HDV, DV50, and DV25

• IMX50 and IMX 30

• DNxHD145/120 (see note)

ISIS engine bandwidth throughput

Number of 
ISIS Engines

DV25/50 & 
IMX 30/50 
Throughput

DXxHD 145/120 
Throughput

1 300 MB/s 240 MB/s

Estimated ISIS engine bandwidth usage

Type of Media
Bandwidth 
Usage

DV25 video 4 MB/sec

DV50 video 8 MB/sec

DNxHD 145 video 18 MB/sec

DNxHD 120 video 16 MB/sec

48 tracks of 48 kHz 24-bit audio 10 MB/sec

48 tracks of 48 kHz 16-bit audio 8 MB/sec
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Performance Characteristics
You should experience no functional difference 
between working with Pro Tools or 
Media Station|PT attached to an ISIS system or 
working with Pro Tools attached to local stor-
age. However, due to the architectural differ-
ences between ISIS and local storage, some sub-
tle differences may be noticeable.

User Interface and Graphics

The Pro Tools workstation is tasked in a com-
pletely different manner when Pro Tools is re-
cording or playing from ISIS storage. For this 
reason, the update speed of the display and the 
responsiveness of the Pro Tools user interface 
might differ somewhat when compared to using 
local storage. When using ISIS storage, the Pro 
Tools workstation might periodically be inter-
rupted by sporadic bursts of communication 
with the System Director. This can cause the dis-
play to not refresh smoothly. These periodic, 
brief interruptions in display updating are most 
prevalent during long recording sessions or 

while playing back large sessions. These inter-
ruptions do not necessarily indicate that a prob-
lem exists and do not affect audio playback. Ex-
cept for these interruptions or when tasks are in 
progress, display and user interface performance 
should be comparable to using local storage. For 
example:

• Counters, meters, scrolling, and other ani-
mated user interface elements are visually 
smooth in operation.

• Faders and panners move smoothly when au-
tomated. 

• Mouse control of faders and panners is imme-
diate and responsive. This includes TDM plu-
gins. RTAS and AudioSuite plug-ins, because 
of their host-based implementation, might 
provide less-than-smooth operation under 
certain circumstances.

• Scrubbing and auditioning (in the Regions 
List and Import Audio dialog) is immediate 
when you press the mouse button.

• Editing during playback is smooth. Mouse 
control of editing tools is immediate and re-
sponsive.

Opening Files

Pro Tools periodically opens and closes files (for 
example, to buffer them for playback). When us-
ing ISIS storage, the file open process is some-
what slower than with local storage. This is most 
noticeable when first opening an existing ses-
sion. It can also result in sluggish Pro Tools per-
formance with very large sessions.

At this time, the editor is qualified with the 
capability of using 2 streams of video and 
up to 8 tracks of audio. This level of func-
tionality allows for better scalability of the 
ISIS environment while still allowing an ad-
equate degree of client performance and 
functionality. Attempting to increase the 
clients stream playback may result in unex-
pected results for the client but should not 
impact the ISIS system. 

DNxHD might result in skipped video 
frames during a heavy system load. To pre-
vent this, you should use 2 streams of video 
and 4 tracks of audio.
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Sharing Files

Sharing Session Files

To avoid machine conflicts among multiple us-
ers and avoid general performance problems, no 
two Pro Tools clients should open the same ses-
sion at the same time. Only one Pro Tools client 
should have a particular session open at any 
given time.

Sharing Video Files

Pro Tools clients with Avid video peripherals 
(such as Avid Mojo, Avid Mojo SDI, and AVop-
tion|V10) can share JFIF and MXF video files 
with other ISIS clients. Pro Tools cannot destruc-
tively modify video files.

Sharing Audio Files

Pro Tools clients can share audio files in an allo-
cation group with other ISIS clients. When 
working with shared audio files, it is recom-
mended that you use the Duplicate command to 
make a copies before applying any destructive 
edits.

MacDrive 6.0 Damages Avid Unity 
Volumes

MacDrive 6.0.6 and the Pro Tools Mac HFS+ 
Disk Support Option both support recognition 
of Avid Unity systems and do not cause the is-
sues mentioned above.

Destructive Editing
The following Pro Tools features can destruc-
tively modify audio files:

• Pencil Tool

• “Destructive” AudioSuite

• Destructive Record

• Compact Selected

• DestructivePunch Record

• DigiBase metadata entry/editing

When working with shared audio files, it is rec-
ommended that you use the Duplicate com-
mand to substitute copies before applying any 
destructive edits. This avoids the problem of 
modifying a file referenced by another session.

To substitute a copy of a shared file:

1  In Pro Tools, select the region you want to 
copy in the Edit window.

2  Choose Edit > Duplicate.

If you have a Windows XP client attached 
to Avid Unity volumes, do not install 
MacDrive 6.0. This application will prompt 
to update the Unity volumes whenever they 
are mounted. Allowing MacDrive 6.0 to up-
date them will result in complete data loss 
for the Unity volumes, and they will need to 
be rebuilt.
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MXF and OMF Files

Pro Tools treats all MXF and OMF media that are 
both created by Avid and stored on Unity shared 
storage as read-only. Consequently, destructive 
editing tools cannot be used to modify MXF and 
OMF media files. However, you can delete or 
overwrite MXF and OMF files.

Because Pro Tools creates both MXF/OMF and 
non-MXF/OMF media files, these destructive ed-
iting tools can be used on non-MXF/OMF media 
created by Pro Tools. When you are working in 
an ISIS system, you should always create a copy 
of an audio file before applying a destructive 
change.

Use the Duplicate or Consolidate com-
mands in Pro Tools to make non-OMF or 
non-MXF copies of audio files for destruc-
tive editing.
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chapter 4

Avid Unity ISIS Workflows for Pro Tools

This chapter covers workflows for using an Avid 
editing application (such as Media Composer or 
Media Station|PT) and Pro Tools to exchange 
AAF sequences using ISIS shared storage, as fol-
lows:

• Exporting audio and video from 
Media Composer 2.5 and higher

• Exporting audio and video using a version of 
Media Composer prior to 2.5

• Importing audio and video into Pro Tools

• Exporting audio from Pro Tools for Avid edit-
ing applications

• Importing audio into an Avid application 
from Pro Tools

• Synchronizing audio with an Avid sequence

Exporting Audio and Video 
from Media Composer 2.5 and 
Higher
To export sequences from Avid applications 2.5 
and higher for import into Pro Tools, you can 
choose from the following methods:

• Using the Send To templates to export an 
AAF sequence

• Manually exporting an AAF sequence

• Exporting an AAF sequence directly to an 
Interplay server (Media Composer 2.6 or 
higher and Avid Interplay system required)

• Checking a sequence into Avid Interplay 
for Pro Tools (Media Composer 2.6 or 
higher and Avid Interplay system required)

Using the Send To Templates to 
Export an AAF Sequence from 
Media Composer 2.5 and Higher

The Send To Templates option lets you create 
one AAF sequence that references audio and 
video files used in the sequence, and save it to 
the volume selected in your Avid Preferences.
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To use the Send To Digidesign Pro Tools 
templates:

1  Select a sequence in a bin.

2  Choose File > Send To > Digidesign Pro Tools 
on Unity, then choose one of the following op-
tions:

Link to Audio and Video Creates an AAF se-
quence that links to existing audio and video 
wherever possible and only creates new media 
files for effects that have not been rendered. This 
is the fastest and most storage-efficient way to 
export a sequence.

Choose this option for a scenario in which 
Pro Tools will link to the same media files as the 
current Avid sequence. Use this setting if the 
media files are currently stored on volumes that 
are suitable for Pro Tools media playback.

QuickTime–Link to Audio Creates an AAF se-
quence that links to existing audio, and creates a 
new QuickTime movie. 

Choose this option when exporting a sequence 
for a Pro Tools system that does not have an 
Avid video peripheral attached.

VIdeo Mixdown–Link to Audio Creates an AAF se-
quence that links to existing audio and includes 
editing metadata as well as a video mixdown in 
the video format defined by Media Creation set-
tings. When imported into Pro Tools, the video 
mixdown and metadata are displayed in two 
separate video tracks on the Timeline.

Choose this option for any scenario in which 
Pro Tools will link to the same media files as the 
current Avid sequence.

3  If you want to view or change export settings, 
click the Options button, and then make any 
changes. If you make any changes, you can use 
the Save As Template button to create a new 
template.

4  Click Set.

5  Navigate to the location where you want the 
AAF sequence to reside.

6  Click OK.

The Avid application exports the files to the des-
tination volume. If the Avid application has to 
transcode video files to a new resolution, render 
effects or perform audio file conversions, a new 
sequence appears in the bin with the name file-
name.Export.01, and a new master clip appears 
in the bin with the name filename.new.01.

Send To dialog (LInk to Audio and Video options shown)

This workflow assumes that you use the de-
fault values. This means that you are ex-
porting using the Project sample rate, audio 
file format, and sample bit depth.
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Manually Exporting an AAF 
Sequence from Media 
Composer 2.5 and Higher

Manually exporting an AAF sequence from an 
Avid editing application involves more steps 
than using the Send To templates, but it pro-
vides more flexibility. 

Once all effects have been rendered, export the 
sequence as an AAF sequence.

To manually export an AAF sequence:

1  Select the sequence in the bin.

2  Select File > Export.

3  Type a name and select a location for the ex-
ported sequence.

4  Select Export to Pro Tools from the Export Set-
tings menu at the bottom of the Export As dia-
log.

5  Click the Options button to open the Export 
to Pro Tools Settings dialog. Verify the settings:

• For Export As, select AAF.

• Select the Include All Video Tracks in Se-
quence option. When the sequence is im-
ported into Pro Tools. All of the video 
tracks will be “flattened” so that the im-
ported sequence shows only a single video 
stream.

6  In the Video Details tab, select one of the fol-
lowing from the Export Method pop-up menu:

Link to (Don’t Export) Media The Pro Tools ses-
sion will link to the same video files as the cur-
rent Avid sequence. Use this setting if the video 
files are currently stored on a volume suitable 
for Pro Tools video playback.

Copy All Media New complete video files will be 
created on the designated volume.

You will need to render all video effects be-
fore manually exporting the sequence.

Export As dialog Export Settings – Export To Pro Tools dialog, Video 
Details tab
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Consolidate Media Similar to Copy All Media, 
but only the parts of the video clips which are 
actually used in the Timeline are copied. Use 
this setting to copy the video files to a volume 
suitable for Pro Tools video playback.

Video Mixdown The exported AAF sequence will 
reference a video mixdown. This setting lets you 
have a choice of whether to export the video 
mixdown alone or the video mixdown along 
with additional video track edits. The choice de-
pends largely on the version of Pro Tools to 
which you are exporting. Pro Tools 7.2 and 
higher can show the video mixdown alongside 
video edits; in this case, you should select both 
the video mixdown and the video edits. For ver-
sions of Pro Tools prior to 7.2, you should ex-
port the video mixdown by itself.

The following settings may also appear under 
the Video Details tab, depending on the selected 
export method:

Media Destinations Choose where to store cop-
ied video files.

Handle Length Extends the beginning and end 
of the consolidated file by the specified number 
of frames. This lets you trim edits later, though 
the sequence would need to be re-edited in the 
Avid application.

Render Video Effects Always select Render Video 
Effects. If you already manually rendered effects, 
selecting this option will not create new files. It 
is highly recommended that all effects be ren-
dered manually before exporting the sequence.

Transcode Video To Use this only if you need to 
change the video resolution. Pro Tools supports 
most SD resolutions supported by Avid, and 
even supports mixed resolutions in the 
Pro Tools Timeline, so in most cases there is no 
need to spend extra time transcoding the video. 
However, if you have video of a resolution 
which is not currently supported by Pro Tools, 
use this setting to transcode it to a supported 
resolution. 

While new video files are typically stored in the 
OMFI MediaFiles folder (for OMF media) or the 
Avid MediaFiles folder (for MXF media), some 
workflows let you choose a different target des-
tination for video in the Media Destination sec-
tion of the Video Details tab, as follows:

Media Drive This option exports media to the 
OMFI MediaFiles folder or Avid MediaFiles 
folder on a connected storage drive. Select the 
Use Media Creation Settings option to use the 
default settings, or deselect that option to 
choose a media drive from the pop-up menu.

Folder This option exports video media to a spe-
cific folder. Select the Use Same Folder as AAF 
File option to export the video media into the 
same folder you designated for exporting the 
AAF sequence, or deselect this option to select a 
specific folder location for the media.

If your Pro Tools system is running on a 
slower computer, you may be able to reduce 
some of the CPU load in Pro Tools by 
transcoding the video to 1:1 on export. 1:1 
video is uncompressed, and consequently it 
does not need to be decompressed before 
playing back. However, 1:1 video requires 
significant amounts of storage space.
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Embedded in AAF This option embeds the video 
media in the AAF sequence that is exported from 
the Avid application. 

7  Click the Audio Details tab, and select one of 
the following from the Export Method pop-up 
menu:

Link to (Don’t Export) Media The Pro Tools ses-
sion will link to the same audio files as the cur-
rent Avid sequence. Use this setting if the audio 
files are currently stored on a volume suitable 
for Pro Tools audio playback.

Copy Media New complete audio files will be 
created on the designated volume.

Consolidate Media Similar to Copy All Media, 
but only the parts of the audio which are actu-
ally used in the Timeline are copied. Use this set-
ting to copy the audio files to a volume suitable 
for Pro Tools audio playback.

The following settings may also appear under 
the Audio Details tab, depending on the selected 
export method:

Render All Audio Effects Select the Render All 
Audio Effects option so that all audio effects are 
rendered before export. If you already manually 
rendered effects, selecting this option will not 
create new files. It is highly recommended that 
all effects be rendered before exporting the se-
quence.

Include Rendered Audio Effects Select the In-
clude Rendered Audio Effects option. Otherwise, 
the exported sequence will include the original 
audio files without any AudioSuite effects from 
the original sequence—even if those effects were 
previously rendered.

Convert Audio Sample Rate/Bit Depth/File For-
mat Select Project for any of these, and the cur-
rent Audio Project Setting will be used.

While new audio files are typically stored in the 
OMFI MediaFiles folder (for OMF media) or the 
Avid MediaFiles folder (for MXF media), some 
workflows let you choose a different target des-
tination for audio in the Media Destination sec-
tion of the Audio Details tab, as follows:

Media Drive This option exports audio media to 
the OMFI or Avid MediaFiles folder on con-
nected storage. Select the Use Media Creation 
Settings option to use the default settings, or de-
select that option to choose a media drive from 
the pop-up menu.

Folder This option exports audio media to a spe-
cific folder. Select the Use Same Folder as AAF 
File option to export the media into the same 
folder you designated for exporting the AAF se-
quence, or deselect this option to select a spe-
cific folder location for the media.

Pro Tools cannot play video that is embed-
ded in an AAF sequence, but it can read the 
video editing metadata when imported into 
a satellite track. Do not use this option if 
you want to import the video itself into 
Pro Tools.

Media Destination section of the Video Details tab
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Embedded in AAF This option embeds the audio 
media in the AAF sequence that is exported from 
the Avid application. Unlike embedded video, 
Pro Tools can import and play audio which is 
embedded in an AAF sequence. Embedding au-
dio within the AAF sequence makes file manage-
ment much simpler because there is only one 
file to move—the sequence. There is a limit of 
2 GB for embedded AAF.

8  Click Save or Save As in the Export Settings di-
alog:

• Click Save to use the specified settings 
whenever Export to Pro Tools is selected 
from the Export Settings menu. These set-
tings will also be used when choosing any 
of the options located at File > Send To > 
Digidesign Pro Tools to Unity. 

• Click Save As to save these settings as a pre-
set with a different name. These settings 
can then be recalled in the Export dialog. If 
you click Save As instead of Save, the Ex-
port to Pro Tools settings will not be 
changed.

9  Click Save in the Export As dialog. (The Export 
Settings cannot be saved until you have selected 
a target drive for both audio and video.)

When the export is complete, you are ready to 
import the file into Pro Tools.

To export only part of a sequence:

1  Choose Clip > New Sequence to create a new 
sequence.

2  In the bin, name the sequence and drag it to 
the Record Monitor.

3  Drag your original sequence to the Source 
Monitor.

Pro Tools cannot play video that is embed-
ded in an AAF sequence, but it can read the 
video editing metadata when imported into 
a satellite track. Do not use this option if 
you want to import the video itself into 
Pro Tools. 

For more information on opening and im-
porting AAF sequences in Pro Tools, see 
“Importing Audio and Video into 
Pro Tools” on page 55. For more informa-
tion on the Import Session dialog, see the 
Pro Tools Reference Guide.

Avid Media Composer main window
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4  Use the controls underneath the Source Mon-
itor to locate the first frame of the portion of the 
clip that you want to edit into the sequence:

• To begin playing the clip, click Play (or 
press the Spacebar). Click Play or press the 
Spacebar again to Pause.

• To move to the beginning of the clip, click 
Rewind (or press the Home key).

• To move to the end of the clip, click Fast-
Forward (or press the End key).

• To nudge by frame, click Step Forward 1 
Frame or Step Backward 1 Frame (or press 
the Left/Right Arrow keys).

• To scrub, click and drag the cursor beneath 
the Source Monitor. (Enable the Caps Lock 
to hear audio while scrubbing.)

5  Click Mark In to mark the In point (the first 
frame of the selected portion of the clip) at the 
current position of the cursor.

6  Using the same controls, locate the last frame 
of the portion of the clip that you want to edit 
into the sequence. 

7  Click Mark Out to mark the Out point (the last 
frame of the selected portion of the clip) at the 
current position of the cursor.

8  Click the Record Monitor to select the empty 
sequence, then press the Home key to move the 
cursor to the beginning of the sequence.

9  Click the Overwrite or Splice-In button. The 
selected portion of old sequence is edited into 
the empty sequence in the Record Monitor.

10  Follow the preceding steps for exporting the 
new sequence (see “Manually Exporting an AAF 
Sequence from Media Composer 2.5 and 
Higher” on page 41).

Checking In a Sequence to 
Interplay for Pro Tools 

(Media Composer 2.6 or Higher with Avid Inter-
play System Only)

This section describes how to use an Avid appli-
cation (such as Media Composer 2.6 or higher) 
to check in a sequence to Interplay for 
Pro Tools.

Source Monitor controls

You can also select the entire clip by clicking 
Mark Clip.

Rewind

Fast-
Forward

Step Forward 1 
Frame

Cursor

Play/ 
Pause

Step Backward 1 
Frame

Mark 
Out

Mark 
In

Clear Both 
Marks

Mark 
Clip

Overwrite and Splice-In buttons

OverwriteSplice-In
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To check in a sequence to Interplay for Pro Tools:

1  In the Avid application, navigate to the bin 
containing the sequence you want to export.

2  Do one of the following:

• Select the sequence, and choose File > 
Check In to Interplay for Pro Tools.

– or –

• Right-click the sequence, and choose 
Check In to Interplay for Pro Tools.

If you have previously set the Editor Export Set-
tings for Pro Tools for the folder, the Pro Tools 
Video Mixdown dialog appears.

3  Select one of the following options:

New Video Mixdown Includes a video mixdown 
in the exported sequence using the resolution 
set in the Project Type pop-up menu of the 
project window’s Format tab. Select this option 
if you are working on an HD project. No video 
effects will be rendered in the project.

Link to Existing Video Media Use this option 
when effects have either been rendered or are 
unnecessary for working in Pro Tools. (Ensure 
that linked video can be played from the 
Pro Tools system.) With this option, the Avid 
application:

• Does not render any effects.

• Determines whether the current resolution 
matches the Transcode resolution in the Edi-
tor Export Settings for Pro Tools plug-in in the 
Interplay Administrator. Depending on 
whether the settings match, one of the follow-
ing occurs:

• If the settings either match or have not 
been created for the check-in folder, the 
system creates a sequence that links to the 
existing media and does not create a video 
mixdown or render any video effects.

• If the settings do not match, the system 
transcodes the sequence according to the 
setting in the Export Settings for Pro Tools 
plug-in and links the sequence to this new 
media. The system also renders (or re-ren-
ders) all video effects to match the 
transcode resolution. The application over-
rides the “Link To” option in order to guar-
antee that you have access to a resolution 
supported by Pro Tools.

4  Click OK to check in the sequence to Interplay 
for Pro Tools.

Bin containing the sequence to export

Video Mix dialog

See the Pro Tools Avid Interplay Guide for 
detailed information.
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After Checking In a Sequence to 
Interplay for Pro Tools

The system exports the sequence from the Avid 
application, and then checks in the sequence to 
Interplay.

If the Interplay folder containing the exported 
sequence has been configured with video and 
audio settings defined in the Editor Export Set-
tings for Pro Tools plug-in, those settings are ap-
plied to the sequence. (These settings can apply 
to either the entire database or to one or more 
folders, depending on how they are configured.)

When you use an Avid application to check in a 
sequence to Interplay for Pro Tools, the system 
chooses a destination folder in the Interplay da-
tabase based on the current Interplay view set-
tings, with the default destination folder as fol-
lows:

Projects\project_name\bin_name

If your check-in destination folder is a folder for 
which settings have not been defined, the sys-
tem displays the Pro Tools Export Settings dia-
log so you can specify the settings. 

Exported Files in Interplay

If this is the first time the you have checked in a 
sequence to Interplay for Pro Tools for this 
project, the system performs the following oper-
ations:

• Checks in the Avid sequence to the bin_name 
folder.

• Creates a Pro Tools folder within the bin_name 
folder.

• Checks in the files for the Pro Tools editor to 
the Pro Tools folder.

• Checks in a Pro Tools sequence to the 
Pro Tools folder.

The first time the sequence is exported, the sys-
tem appends the text “_v1_forPT” to the se-
quence name in the Pro Tools folder. Each sub-
sequent time the sequence is exported, it uses 
the text “_v2_forPT,” “_v3_forPT,” and so on.

Pro Tools Export Settings dialog

Location of the Avid sequence and its associated 
Pro Tools folder

The name matches the name in the 
Avid application bin
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The following illustration shows the contents of 
the Pro Tools folder after the first export.

Exporting Audio and Video 
using a Version of Media 
Composer Prior to 2.5
To export sequences from versions of Avid ap-
plications (such as Media Composer) prior to 2.5 
for import into Pro Tools, you can choose from 
the following methods:

• Using the Send To templates to export an AAF 
sequence

• Manually exporting an AAF sequence

• Creating a video mixdown

Using the Send To Templates to 
Export an AAF Using Versions of 
Media Composer Prior to 2.5

The Send To Templates option lets you create 
one metadata AAF sequence that references au-
dio and video files used in the sequence, and 
save it to the volume selected in your Avid Pref-
erences.

To use the Send To Digidesign Pro Tools 
templates:

1  Select a sequence in a bin.

2  Choose File > Send To > Digidesign Pro Tools, 
then choose one of the following options:

Link to Audio and Video Creates a sequence 
which links to existing audio and video wher-
ever possible and only creates new media files 
for effects that have not been rendered. 

Choose this option for a single-user scenario in 
which Pro Tools will link to the same media files 
as the current Avid sequence. Use this setting if 
the media files are currently stored on volumes 
that are suitable for Pro Tools media playback 
and recording.

Consolidate-Link Audio and Video Exports only 
the portion of the audio and video files that are 
actually used in the edited sequence. One se-
quence file is created, along with a new file for 
each clip in the timeline. This is similar to the 
Consolidate command in Pro Tools. New files 
are created in the formats specified in the Media 
Creation and Audio Project Settings dialogs. 

Contents of Pro Tools folder (left pane) and sequence 
listed in that directory (right pane)

The red dots in the illustration indicate that 
the system has placed a reservation on the 
files to prevent unauthorized deletion for a 
fixed period of time. For more information, 
see the Avid Interplay Access User’s Guide.

For details on exporting audio and video us-
ing Media Composer 2.5 and higher, see 
“Exporting Audio and Video from Media 
Composer 2.5 and Higher” on page 39.

Red dots “_v1_forPT” appended to the 
sequence name

AAF exports ignore in and out marks, but 
QuickTime exports do not. The default tem-
plates that create QuickTime movies auto-
matically deselect the “Use in and out 
marks” option.
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Consolidating media will place new files on 
drives specified in those dialogs. New video files 
will be stored in the OMFI MediaFiles folder (for 
OMF media) or the Avid MediaFiles folder (for 
MXF media). You should be certain that the 
drives to which you are exporting currently 
have no media in those folders.

Choose this option for a multi-user scenario in 
which the Pro Tools editor only needs access to 
the material in the sequence and is likely work-
ing on a different computer or volume.

3  If you want to view or change export settings, 
click the Options button, and then make any 
changes (such as switching from the default AAF 
to the OMF format). If you make any changes, 
you can use the Save As Template button to cre-
ate a new template.

4  Click Set.

5  Navigate to the location where you want the 
AAF sequence to reside.

6  Click OK.

The Avid application exports the files to the des-
tination folder. If the Avid application has to 
transcode video files to a new resolution, render 
effects or perform audio file conversions, a new 
sequence appears in the bin with the name file-
name.Export.01, and a new audio master clip ap-
pears in the bin with the name filename.new.01.

Manually Exporting an AAF 
Sequence Using Versions of Media 
Composer Prior to 2.5

Once all effects have been rendered, export the 
sequence as an AAF sequence.

To manually export an AAF sequence:

1  Select the sequence in the bin.

2  Select File > Export.

3  Type a name and select a location for the ex-
ported sequence.

Send To Link to Audio and Video dialog

This workflow assumes that you use the de-
fault values. This means that you are ex-
porting using the Project sample rate, audio 
file format, and sample bit depth.

You will need to render all video effects be-
fore manually exporting the sequence.

Export As dialog
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4  Select Export to Pro Tools from the Export Set-
tings menu at the bottom of the Export As dia-
log.

5  Click the Options button to open the Export 
to Pro Tools Settings dialog. Verify the settings:

• For Export As, select AAF.

• Select the Include All Video Tracks in Se-
quence option. When the sequence is im-
ported into Pro Tools. All of the video 
tracks will be “flattened” so that the im-
ported sequence shows only a single video 
stream.

• Deselect the Include All Audio Tracks in Se-
quence option if you do not want to export 
any audio.

6  In the Video Details tab, select one of the fol-
lowing from the Export Method pop-up menu:

Link to Current Media The Pro Tools session will 
link to the same video files as the current Avid 
sequence. 

Choose this setting in a single-user scenario in 
which the video files are currently stored on a 
volume suitable for Pro Tools video playback 
(such as an ISIS volume).

Copy Media and Link to Copied Media New com-
plete video files will be created on the desig-
nated volume. 

Choose this option in a multi-user scenario in 
which the Pro Tools user is receiving the se-
quence for the first time and will copy the media 
to their respective Workspace.

Consolidate and Link to Consolidated Media Sim-
ilar to Copy Media, but only the parts of the 
video clips which are actually used in the Time-
line are copied. 

Choose this setting in a multi-user scenario in 
which the Pro Tools user may already be work-
ing on media from the sequence, and will copy 
the changed material to their respective Work-
space.

The following settings may also appear under 
the Video Details tab, depending on the selected 
export method:

Destination Folder Choose where to store copied 
video files.

Target Drive for Consolidate Choose the target 
drive for consolidated video. New video files will 
be stored on that drive in the OMFI MediaFiles 
folder (for OMF media) or the Avid MediaFiles 
folder (for MXF media). You should be certain 
that the drives to which you are exporting cur-

Export Settings – Export To Pro Tools dialog, Video 
Details tab

Do not use either Embed Media or Consoli-
date and Embed Media for video files. 
Pro Tools does not support embedded video 
files in AAF sequences.
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rently have no media in those folders. You can-
not save these export settings until you have 
highlighted a target volume. Striped drives ap-
pear in bold type.

Handle Length Extends the beginning and end 
of the consolidated file by the specified number 
of frames. This lets you trim edits later, though 
the sequence would need to be re-edited in the 
Avid application. 

Render Video Effects Always select Render Video 
Effects. If you already manually rendered effects, 
selecting this option will not create new files. It 
is highly recommended that all effects be ren-
dered manually before exporting the sequence.

Transcode Video To Use this only if you need to 
change the video resolution. Pro Tools with an 
Avid video peripheral supports all resolutions 
supported by Avid applications, so in most cases 
this will not be necessary.

7  Click the Audio Details tab, and select one of 
the following from the Export Method pop-up 
menu:

Link to Current Media The Pro Tools session will 
link to the same audio files as the current Avid 
sequence. Choose this setting in a single-user 
scenario in which the audio files are currently 
stored on a volume suitable for Pro Tools audio 
playback (such as an ISIS volume).

Copy Media and Link to Copied Media New com-
plete audio files will be created on the desig-
nated volume. 

Choose this option in a multi-user scenario in 
which the Pro Tools user is receiving the se-
quence for the first time and will copy the media 
to their respective Workspace.

Consolidate and Link to Consolidated Media Sim-
ilar to Copy Media, but only the parts of the au-
dio files which are actually used in the Timeline 
are copied. 

Choose this setting in a multi-user scenario in 
which the Pro Tools user may already be work-
ing on media from the sequence, and will copy 
the changed material to their respective Work-
space.

The following settings may also appear under 
the Audio Details tab, depending on the selected 
export method:

If your Pro Tools system is running on a 
slower computer, you may be able to reduce 
some of the CPU load in Pro Tools by 
transcoding the video to 1:1 on export. 1:1 
video is uncompressed, and consequently it 
does not need to be decompressed before 
playing back. However, 1:1 video requires 
significant amounts of storage space.

Export Settings dialog, Audio Details tab

Do not use either Embed Media or Consoli-
date and Embed Media for video media. 
Pro Tools does not import the video from 
AAF sequences containing embedded video.
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Render All Audio Effects Select the Render All 
Audio Effects option so that all audio effects are 
rendered before export. If you already manually 
rendered effects, selecting this option will not 
create new files. It is highly recommended that 
all effects be rendered manually before export-
ing the sequence.

Include Rendered Audio Effects Select the In-
clude Rendered Audio Effects option. Otherwise, 
the exported sequence will include the original 
audio files without any AudioSuite effects from 
the original sequence—even if those effects were 
previously rendered.

Convert Audio Sample Rate/Bit Depth/File For-
mat Select Project for any of these, and the cur-
rent Audio Project Setting will be used.

8  Click Save or Save As in the Export Settings di-
alog:

• Click Save to use the specified settings 
whenever Export to Pro Tools is selected 
from the Export Settings menu. These set-
tings will also be used when choosing File > 
Send To > Digidesign Pro Tools. 

• Click Save As to save these settings as a pre-
set with a different name. These settings 
can then be recalled in the Export dialog. If 
you click Save As instead of Save, the Ex-
port to Pro Tools settings will not be 
changed.

9  Click Save in the Export As dialog. (The Export 
Settings cannot be saved until you have selected 
a target drive for both audio and video.)

When the export is complete, you are ready to 
import the file into Pro Tools.

To export only part of a sequence:

1  Choose Clip > New Sequence to create a new 
sequence.

2  In the bin, name the sequence and drag it to 
the Record Monitor.

3  Drag your original sequence to the Source 
Monitor.

4  Use the controls underneath the Source Mon-
itor to locate the first frame of the portion of the 
clip that you want to edit into the sequence:

• To begin playing the clip, click Play (or 
press the Spacebar). Click Play or press the 
Spacebar again to Pause.

• To move to the beginning of the clip, click 
Rewind (or press the Home key).

• To move to the end of the clip, click Fast-
Forward (or press the End key).

• To nudge by frame, click Step Forward 1 
Frame or Step Backward 1 Frame (or press 
the Left/Right Arrow keys).

• To scrub, click and drag the cursor beneath 
the Source Monitor. (Enable the Caps Lock 
to hear audio while scrubbing.)

For more information on opening and im-
porting AAF sequences in Pro Tools, see 
“Importing Audio and Video into 
Pro Tools” on page 55. For more informa-
tion on the Import Session dialog, see the 
Pro Tools Reference Guide.

Avid Media Composer main window
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5  Click Mark In to mark the In point (the first 
frame of the selected portion of the clip) at the 
current position of the cursor.

6  Using the same controls, locate the last frame 
of the portion of the clip that you want to edit 
into the sequence. 

7  Click Mark Out to mark the Out point (the last 
frame of the selected portion of the clip) at the 
current position of the cursor.

8  Click the Record Monitor to select the empty 
sequence, then press the Home key to move the 
cursor to the beginning of the sequence.

9  Click the Overwrite or Splice-In button. The 
selected portion of old sequence is edited into 
the empty sequence in the Record Monitor.

Follow the preceding steps for exporting the 
new sequence.

Creating a Video Mixdown Using 
Versions of Media Composer Prior 
to 2.5

Video mixdown combines a sequence (or por-
tion of a sequence) into one video file that re-
flects all edits and effects processing. Creating a 
video mixdown is a manual process prior to Me-
dia Composer 2.5 and higher. With Media Com-
poser 2.5 and higher, an option exists in AAF ex-
port to create a video mixdown automatically.

You can mix down multiple video tracks or a 
single track. For mixdowns of multiple tracks, 
the selected track and all tracks under it are com-
bined into one file that always reflects the top-
most visible track.

Source Monitor controls

You can also select the entire clip by clicking 
Mark Clip.

Overwrite and Splice-In buttons

Rewind

Fast-For-
ward

Step Forward
1 Frame

Cursor

Play/
Pause

Step Backward
1 Frame

Mark
Out

Mark
In

Clear Both
Marks

Mark
Clip

OverwriteSplice-In

Creating a video mixdown is analogous to 
bouncing to disk in Pro Tools, except that 
the video mixdown creates only video and 
no audio.

Layered video tracks in a video mixdown

Track layers reflected
in video mixdown
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To create a video mixdown:

1  Open the bin containing the sequence you 
want to mix down.

2  Drag the sequence to the Record Monitor. The 
tracks comprising the sequence display in the 
Timeline.

3  Do one of the following:

• To combine multiple video tracks into the 
mixdown, select a video track, then click 
the Record Track Monitor button next to 
the track. Video tracks above the selected 
track will not be included in the mixdown.

– or –

• To select only one video track for mix-
down, Control-click (Windows) or Com-
mand-click (Macintosh) the Record Track 
Monitor button. The button will turn 
green.

4  On the Timeline or in the Record Monitor, 
drag the cursor to the position in the sequence 
at which you wish the mixdown to start. (Press 
the Home key to move the cursor to the begin-
ning of the Timeline.)

Record and Source Monitors

Record Track monitor

Record Track monitor

Record Track
Monitor

Record Track
Monitor (solo)
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5  Under the Record Monitor, click the Mark In 
button to mark the In point at the beginning of 
the sequence.

6  Drag the cursor to the position at which you 
want the sequence to end. (Press the End key to 
move the cursor to the end of the sequence.)

7  Click Mark Out button to set the Out point.

The portion of the sequence you have selected 
will be mixed down.

8  Choose Special > Video Mixdown.

9  From the Target bin pop-up menu, choose the 
bin where you wish to store the master clip of 
the video mixdown.

10  From the Target Drive pop-up menu, choose 
the volume where you wish to save the video 
mixdown. On the volume you select, MXF files 
are stored in the Avid MediaFiles folder, and 
OMF files are stored in the OMFI MediaFiles 
folder.

11  Choose a file resolution for the video mix-
down from the Resolution pop-up menu.

12  Click OK.

A progress bar displays as the Avid application 
saves the video mix to the location and resolu-
tions you have specified.

Importing Audio and Video 
into Pro Tools
To import sequences exported from Avid appli-
cations into Pro Tools, you can choose from the 
following methods:

• Importing an AAF sequence as a Pro Tools 
session

• Importing an AAF sequence into an exist-
ing Pro Tools session

• Importing a video mixdown into Pro Tools

• Importing an AAF sequence into Pro Tools 
from Interplay (Pro Tools Avid Interplay 
Option and an Avid Interplay system re-
quired)

Importing an AAF Sequence as a 
Pro Tools Session

The easiest way of using Pro Tools to edit a se-
quence exported from an Avid application is to 
open it as a new session. 

To open an AAF sequence as a Pro Tools session:

1  Launch Pro Tools.

2  Choose File > Open Session.

3  In the Open Session dialog, navigate to the 
AAF sequence you want to import.

Record Monitor controls

Video Mixdown dialog

Mark
Out

Mark
In
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4  Click Open.

5  Name your session in the File Name field.

6  Select the I/O Settings to use for the session. 
Several pre-configured I/O Settings are included 
with your system, or you can select a custom I/O 
Setting that you have created.

7  Click Save.

The Import Session Data dialog appears.

Pro Tools New Session dialog

Import Session Data dialog

Pro Tools lets you open and import AAF se-
quences that reference audio files with 
mixed sample rates and/or bit depths. Audio 
files will be converted to the highest sample 
rate and bit depth of the files being imported 
(for new sessions) or to the current sample 
rate and/or bit depth (for existing sessions). 
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8  From the Audio Media Options pop-up menu, 
choose how you want to import audio files into 
Pro Tools:

• If the audio files reside on a volume from 
which Pro Tools can play back audio, select 
Link to Source Media (Where Possible).

• If the audio files reside on a volume from 
which Pro Tools cannot play back audio, 
select Copy from Source Media to copy all 
audio to the Pro Tools audio storage or 
Consolidate from Source Media to copy 
only the portions of the audio used in the 
Pro Tools Timeline to the Pro Tools audio 
storage.

9  From the Video Media Options pop-up menu, 
choose how you want to import video files into 
Pro Tools:

• If the video files reside on a volume from 
which Pro Tools can play back video, select 
Link to Source Media.

• If the video files reside on a volume from 
which Pro Tools cannot play back video, 
select Copy from Source Media to copy all 
video to the Pro Tools video storage.

10  Change other parameters as desired. For 
more information, see “Exporting Audio from 
Pro Tools for Avid Editing Applications” on 
page 63.

11  Click OK.

Pro Tools will create a new Audio Files folder, a 
Fade Files folder, a Video Files folder, a 
cache.wfm file, and a session file at the desig-
nated locations. This session will match the au-
dio file type, sample rate, and bit depth of the 
audio in the AAF sequence you selected.

Importing an AAF Sequence into 
an Existing Session

You can import an AAF sequence containing au-
dio and video media into an existing Pro Tools 
session. 

To open and import audio and/or video tracks from 
an AAF sequence:

1  Open an existing Pro Tools session.

2  Choose File > Import > Session Data, and 
choose the AAF sequence that you wish to im-
port.

Any video imported into Pro Tools must be 
the same frame rate as video already placed 
in the Timeline. 

Pro Tools cannot play video that is embed-
ded in an AAF sequence, but it can read the 
video editing metadata when imported into 
a satellite track. Do not use this option if 
you want to import the video itself into 
Pro Tools. 

You can also open an AAF sequence by 
dragging it from any location on your com-
puter or the DigiBase browser to the 
Pro Tools Timeline.
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3  From the Audio Media Options pop-up menu, 
choose how you want to import audio files into 
Pro Tools:

• If the audio files reside on a volume from 
which Pro Tools can play back audio, select 
Link to Source Media (Where Possible).

• If the audio files reside on a volume from 
which Pro Tools cannot play back audio, 
select Copy from Source Media to copy all 
audio to the Pro Tools audio storage or 
Consolidate from Source Media to copy 
only the audio used in the session to the 
Pro Tools audio storage.

4  From the Video Media Options pop-up menu, 
choose how you want to import video files into 
Pro Tools:

• If the video files reside on a volume from 
which Pro Tools can play back video, select 
Link to Source Media.

• If the video files reside on a volume from 
which Pro Tools cannot play back video, 
select Copy from Source Media to copy all 
video to the Pro Tools video storage.

5  In the Import Session Data dialog, deselect 
any source tracks that you do not want to be im-
ported. (If you are importing Session Data from 
AAF sequences, all tracks are selected by default. 
If you are importing tracks from a Pro Tools ses-
sion, no tracks are selected by default.)

6  Click OK.

7  If your audio or video source media is on a vol-
ume that is not suitable for playback (shown as a 
Transfer volume in the Workspace browser) or if 
your ISIS workspace privileges are read-only, 
Pro Tools displays a dialog that guides you to 
copy the media to a volume designated for Play-
back or Record. (Click Yes.)

Pro Tools imports the audio and video media to 
the Timeline. Audio tracks with mixed sample 
rates and/or bit depth are automatically con-
verted to the same sample rate and bit depth as 
the session.

Now you are ready to edit the audio files in 
Pro Tools.

Import Session Data dialog

If there are any errors or region name trun-
cations, a dialog will appear asking you if 
you want a detailed report of the changes. 
Click Yes and choose where you want to 
save the log.
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Drive Selection When Importing 
Session Data

When using the Import Session Data dialog to 
import audio files with Copy or Consolidate 
Source selected in the Audio Media Options 
pop-up menu, all new audio files are stored on 
the volumes designated for their respective tar-
get tracks in the Disk Allocation dialog.

Selecting a Unity Workspace When 
Importing Session Data

When using the Import Session Data dialog to 
import audio files with Copy or Consolidate 
Source selected in the Audio Media Options 
pop-up menu, all new audio files are stored on 
the volumes designated for their respective tar-
get tracks in the Disk Allocation dialog.

When importing video files (such as from a CD), 
the video files are copied by default to the same 
volume that holds the session file. To have the 
files copied to another volume, open the Work-
space browser, and select T in the volume desig-
nation column for all volumes except the vol-
ume where you want the video to be stored. To 
ensure that the files are not copied to the root 
level of the volume, create a folder with the ses-
sion name on the desired Unity workspace, then 
create a folder within that session folder named 
Video Files.

Importing an Avid Video Mixdown 
into Pro Tools
(Versions of Media Composer Prior to 2.5 
Only)

You can import an OMF or MXF video file into 
Pro Tools. You might do this, for example, to 
import a video mixdown created in the Avid ap-
plication.

To import Avid video into Pro Tools:

1  Create a new Pro Tools session or open an ex-
isting session.

2  Choose File > Import > Video.

3  In the Select Video File to Import dialog, lo-
cate the video file in the Avid MediaFiles folder 
(for MXF media) or OMFI MediaFiles folder (for 
OMF media) stored on your video storage.

4  Click Open.

Pro Tools imports the video file into the Video 
track.

Importing a Sequence into 
Pro Tools from Interplay
(Avid Interplay System Only)

This section describes how to locate a sequence 
that has been exported to the Interplay database 
from the Avid application and import it into 
Pro Tools. This section assumes that you have 
already configured the Pro Tools Import settings 
in the Interplay Administration tool. 

Select Video Files to Import dialog

For more information, see the Pro Tools 
Avid Interplay Guide.
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If you do not establish Pro Tools Import Settings 
before importing the sequence into Pro Tools, 
you can select the appropriate values in the Im-
port Session Data dialog during the import pro-
cess.

When importing a sequence from Interplay into 
Pro Tools, you can import into a new or existing 
session. 

Importing a Sequence into Pro Tools 
from within Interplay

To check out the sequence and import it into 
Pro Tools from within Avid Interplay Access:

1  If you want to import the sequence into an ex-
isting session in Pro Tools, launch Pro Tools and 
open that session.

2  Start Avid Interplay Access.

3  Navigate to the Pro Tools folder containing 
the sequence you want to import.

4  Right-click the sequence, and choose Import 
to Digidesign Pro Tools.

Importing a Sequence from Interplay 
from within Pro Tools

This section describes how to use Pro Tools to 
import a sequence from Interplay. If you have 
not yet opened Interplay Access and specified a 
server to connect to, you must do that before 
performing this procedure. 

To check out the sequence and import it into 
Pro Tools from within Pro Tools:

1  Start Pro Tools.

2  If you want to import the sequence into an ex-
isting session, open that session.

3  Choose File > Import > Sequence from Avid 
Interplay.

Navigating to the sequence

Importing a sequence into Pro Tools from within Access

See “Importing a Sequence into Pro Tools 
from within Interplay” on page 60 for de-
tailed information.
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The Interplay Engine Browser appears.

4  In the Interplay Engine Browser, expand the 
Interplay database by clicking the plus sign (+) 
next to it.

5  Expand the root folder of the database—usu-
ally titled AvidWG or a variation thereof—by 
clicking the plus sign (+) next to its name. 

6  Expand the Projects folder.

7  Expand the project containing the sequence 
you want to check out and import to Pro Tools.

The Logon to Interplay dialog appears.

8  Enter your username and password, and click 
OK.

9  In the Interplay Engine Browser, locate and se-
lect the sequence that you want to import.

10  Click OK. 

11  If the Name the Session dialog appears, nav-
igate to the appropriate location either on local 
storage or on a dedicated Unity workspace, and 
click Save.

Interplay Engine Browser

The folder structure matches the structure in 
Interplay Access.

Logon to Interplay dialog

Interplay
database

Interplay Engine Browser (folder structure displayed)

Files that appear in greyed out text out are 
not available for import into Pro Tools.

Name the Session dialog

This dialog does not appear if you are im-
porting a sequence into an existing session.
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12  If the Pro Tools Import Session Data dialog 
appears, select the appropriate options and click 
OK.

Pro Tools imports the sequence, copies any me-
dia (if the settings require copying), and displays 
the imported sequence within the Pro Tools ses-
sion. 

Editing Audio in Pro Tools
Audio files created in the Avid application are ei-
ther OMF or MXF files, which Pro Tools cannot 
edit destructively.

When you use Pro Tools to perform a destruc-
tive edit (such as using AudioSuite processing to 
replace the original sound), it creates a new copy 
of the file and leaves the original untouched.

Import Session Data dialog

This dialog does not appear if you config-
ured the Pro Tools Import Settings in the 
Avid Interplay Administrator. Pro Tools au-
tomatically uses those settings to import the 
sequence. (See the Pro Tools Avid Interplay 
Guide for detailed information on configur-
ing Pro Tools Import Settings, and the Digi-
Translator Guide for detailed information 
on setting options in this dialog.)

If the sequence was linked to media files on 
unmounted volumes, the system provides a 
warning and asks you to mount those vol-
umes before you proceed with copying or 
linking to media.

Sequence imported from Interplay into the Timeline

See the Pro Tools Reference Guide for de-
tailed information on editing audio files in 
Pro Tools.
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Exporting Audio from 
Pro Tools for Avid Editing 
Applications
In Pro Tools, you can export audio tracks for use 
in the Avid application using any of the follow-
ing commands:

• Exporting selected tracks as an AAF se-
quence

• Bouncing to disk

• Exporting selected regions as files

• Exporting edited audio tracks to Interplay 
from Pro Tools (Avid Interplay system re-
quired)

For other export methods, see the Pro Tools Ref-
erence Guide.

Exporting Tracks as an AAF 
Sequences

Use Export Selected Tracks as OMF/AAF to ex-
port individual tracks or an entire Pro Tools ses-
sion in AAF format.

To export selected audio tracks from Pro Tools as 
an AAF sequence:

1  In Pro Tools, select the tracks you want to ex-
port in the Pro Tools session by Shift-clicking 
the names of each track.

2  Choose File > Export > Selected Tracks as 
OMF/AAF.

3  Under OMF/AAF Options, choose AAF (or 
OMF) from the Export As pop-up menu.

4  Select Enforce Avid Compatibility.

Enforce Avid Compatibility creates frame-accu-
rate edits, wraps the files as OMFI (unless you 
choose MXF), and limits the sample rate options 
to 44.1 or 48 kHz. Dithering without noise shap-
ing will be applied to files being exported from 
24-bit to 16-bit.

Tracks are exported in their entirety and 
time selections are ignored.

Volume and pan automation is not retained 
on export if Quantize Edits to Frame Bound-
aries is enabled (Avid Compatibility Mode).

The Movie track cannot be exported to AAF 
or OMF from Pro Tools.

Pro Tools Export to OMF/AAF dialog

An OMF sequence cannot reference MXF 
media files. In the Export Selected Tracks as 
OMF/AAF dialog, MXF is only available 
when AAF is selected in the Export As pop-
up menu
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5  Ensure that the Target Project Time Code For-
mat pop-up menu displays the correct frame 
rate for the Avid project. 

6  Click OK. 

7  In the Publishing Options dialog, type the 
Pro Tools Comment and Sequence Name. 

8  Click OK.

Pro Tools will create a sequence with the name 
you supply. (The Pro Tools comment appears in 
the Avid bin in a Pro Tools Comment column.)

9  In the Name the AAF/OMF File to Export dia-
log, navigate to a folder where you can easily lo-
cate the Pro Tools composition when it is time 
to import it into the Avid application.

10  Click Save.

11  In the Please Choose a Folder for Converted 
Audio Files dialog, do one of the following:

• If you are exporting to the same storage 
that Avid application will be accessing, 
navigate to the OMFI MediaFiles folder 
(AIFF or WAV files) or the Avid MediaFiles 
folder (MXF files).

– or –

• If you are exporting to a location that is not 
directly accessible to the Avid application, 
navigate to a location where you can easily 
find the audio files when you need to copy 
them over to the Avid computer.

12  Click Use Current Folder (Windows) or 
Choose (Macintosh).

Pro Tools exports the following files:

• The AAF sequence is saved to the folder you 
designated.

• If you exported audio files directly to the 
Avid application video storage, related me-
dia is saved to the appropriate volume and 
folder (OMFI MediaFiles or Avid Media-
Files) accessible to the Avid application.

Pro Tools Publishing Options dialog

Pro Tools Name the AAF File to Export dialog (OMF 
dialog not shown)

Do not save the sequence to either the OMFI 
Media Files folder or the Avid Media Files 
folder.

Navigating to the OMFI MediaFiles folder (OMF media) 
or Avid MediaFiles folder (AAF media)
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13  Do one of the following:

• If you are using the Avid application on the 
same computer as Pro Tools and are ready 
to use it to import the files you just ex-
ported from the Avid application, exit 
Pro Tools.

• If you were unable to save the audio por-
tion of the AAF sequence directly to storage 
that is accessible from the Avid application, 
copy the audio files from their saved loca-
tion to the OMFI MediaFiles folder (for 
AIFF or WAV media) or Avid MediaFiles 
folder (for MXF media) on a drive con-
nected to your Avid system.

Exporting Audio Files Using 
Bounce to Disk

Use the Bounce to Disk command to create pre-
mixed files of the current Pro Tools session. This 
does not export all of the individual files on the 
Timeline, but it does guarantee that the mix you 
hear in the Avid application will be identical to 
the mix you hear in Pro Tools, including all pan-
ning, effects and automation.

To export audio files using Bounce to Disk:

1  In Pro Tools, finalize the mix.

2  Select the time range of the session that you 
want to export. (All audible tracks in that time 
range will be included in the bounce, whether 
they are selected or not.)

3  Choose File > Bounce to > Disk.

4  Select the Enforce Avid Compatibility option.

Enforce Avid Compatibility creates frame-accu-
rate edits, wraps the files as OMFI (unless you 
choose MXF), and limits the sample rate options 
to 44.1 or 48 kHz. Dithering without noise shap-
ing will be applied to files being bounced from 
24-bit to 16-bit.

5  Choose a file type from the File Type pop-up 
menu.

6  Click Bounce.

7  In the Publishing Options dialog, type the 
Pro Tools Comment and Clip Name.

If you selected more than one region for export, 
the Clip Name field will not be available and the 
names of the regions will be used for the ex-
ported files.

8  Choose the Target Project Time Code Format. 

Bounce to Disk dialog

Publishing Options dialog
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9  Click OK.

10  In the Save Bounce As dialog, navigate to the 
volume you will use for audio playback in the 
Avid application. 

• For MXF audio files, ensure the file is saved 
to the Avid MediaFiles folder.

• For all other audio files, ensure the file is 
saved to the OMFI MediaFiles folder.

11  Click Save.

All audible audio in the selection will be ex-
ported to two multi-mono audio files.

Exporting Edited Audio Tracks to 
Interplay from Pro Tools
(Media Composer 2.6 or Higher and Avid 
Interplay Systems Only)

After you edit the audio material from the se-
quence, you can export the audio tracks back 
into the sequence in Interplay.

To export audio tracks from Pro Tools, and then 
check in audio tracks to Interplay:

1  In Pro Tools, select the tracks that you want to 
export into the Pro Tools sequence on Interplay.

2  Select File > Export > Selected Tracks to Se-
quence in Avid Interplay.

3  In the Export Comment dialog, type a com-
ment and click OK.

4  In the Replace or Add Selected Tracks dialog, 
select a method for laying back edited audio ma-
terial into the Pro Tools sequence residing on 
the Interplay server:

Replace with Selected Tracks Replaces the old 
audio tracks in the Pro Tools sequence with the 
edited audio tracks. Select this option if you do 
not want to preserve the original audio in the se-
quence. 

It is recommended that you provide com-
pleted audio stems rather than audio tracks 
with edits.

Export Comment dialog
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Add Selected Tracks Adds the edited audio 
tracks to the Pro Tools sequence on the Inter-
play database. Select this option if you want to 
preserve the original audio in the sequence.

5  Click OK.

A confirmation message box appears.

6  Click OK.

The sequence in the Avid Interplay database is 
now ready to be checked out and imported by 
the Avid application.

Importing Audio into an Avid 
Application from Pro Tools
Once you have exported audio files or sequences 
from Pro Tools, you may import them into a bin 
in the Avid application.

Importing Audio Files into a Bin

To import audio files into the Avid application:

1  Launch the Avid application, and open the de-
sired project.

2  Open the bin into which you wish to import 
the audio files from Pro Tools.

3  Choose Tools > Media Tool. 

The Media Tool Display lets you scan all media 
files in both the OMFI MediaFiles and Avid Me-
diaFiles folders.

4  Select the Master Clips and the Media Clip op-
tions.

When adding selected tracks, ensure that 
the total number of tracks in the sequence 
residing on the Interplay server does not ex-
ceed the total allowed number of tracks for 
an Avid application—24 audio and 24 
video tracks.

Replace or Add Selected Tracks dialog

Media Tool Display
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5  Under the Media Drives list, do one of the fol-
lowing:

• Select the drives that contain media files 
for your project.

– or –

• Click All Drives to select all applicable 
drives for scanning.

6  Under the Projects list, click All Projects to 
scan all available media files.

7  Click OK.

The Media Tool window appears, displaying the 
media you selected.

8  To sort the files in the bin by a specific column 
(such as Name or Creation Date), right-click the 
column and select “Sort on Column, Ascend-
ing” or “Sort on Column, Descending.”

9  In the Media Tool window, select the Stereo 
(or multi-mono) master clip exported from 
Pro Tools.

10  Drag the master clip to the bin.

11  Close the Media Tool.

12  To preview the contents of the imported au-
dio clip, double-click the audio clip in the bin. 
The audio clip will open in a pop-up monitor.

Importing an AAF Audio Sequence 
into a Bin

To import an AAF sequence into the Avid 
application:

1  Launch the Avid application, and open the de-
sired project.

2  Select the bin where you would like to import 
the sequence.

3  Choose File > Import.

4  In the Select Files to Import dialog, navigate to 
the sequence you wish to import, and ensure the 
correct drive is selected for audio.

5  Click Open. The new audio sequence appears 
in the selected bin, along with all related audio 
clips.

One of the following occurs:

• If you imported an AAF sequence containing 
embedded audio, the Avid application auto-
matically copies the embedded audio to either 
the Avid MediaFiles folder or the OMFI Medi-
aFiles folder.

• If you imported an AAF sequence that refer-
ences audio—and the Avid editing applica-
tion does not have direct access to the audio—
you must copy the audio files from the 
Pro Tools audio storage to either the Avid Me-
dia Files folder or the OMFI MediaFiles folder.

6  To hear the contents of the imported audio se-
quence, double-click the audio sequence in the 
bin. The audio sequence opens in a pop-up 
monitor or in the Timeline (depending on your 
Bin settings). Press the Spacebar to play. 

Media Tool
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Importing Pro Tools Audio Files 
Back into the Avid Editing 
Application
(Media Composer 2.6 or Higher and Avid 
Interplay Systems Only)

After you have checked out the completed audio 
stems to the Pro Tools sequence on the Interplay 
server, you must import the sequence back into 
the Avid application.

To import the sequence back into the Avid editing 
application:

1  In the Avid application, open the Interplay 
Window and navigate to the location of the 
checked in Pro Tools sequence.

2  Drag the sequence into the bin.

The Avid application checks out the sequence 
and imports it and its related files into the bin.

3  You can now do one of the following: 

• Add the new audio tracks into the original 
sequence.

– or –

• Work with the imported sequence.

In this example, the Pro Tools audio tracks are 
added into the original sequence.

4  Load the imported sequence into the Source 
monitor.

5  Add the audio into the original sequence us-
ing standard editing techniques. 

Interplay browser

Depending on edits made in Pro Tools, you 
might see several audio files with names 
containing the prefix “Sample accurate 
edit.” For more information, see “Frame-
Rate Accurate Video Editing and Sample-
Rate Accurate Audio Editing” on page 70.

Pro Tools folder Files checked in by 
the Pro Tools editor

Bin after import

If you plan to check in the sequence to Inter-
play for Pro Tools again, it is simpler to im-
port the audio into the original sequence. 
Every time you export a sequence for 
Pro Tools, the system appends the text 
“_vx_forPT,” where x is the number of 
times the sequence has been exported. It can 
become confusing if several similar text 
strings are appended to the name.

For more information, see the documenta-
tion (PDF or Help file) for your Avid editing 
application.

Imported
sequence

Video mixdown
created during

first check in to
Interplay

Original
sequence
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The following illustration shows the audio 
tracks cut into the original sequence. In this ex-
ample, the original tracks are overwritten. 

6  Now you can use the Avid application to make 
any adjustments to the sequence and do the fol-
lowing:

• Create a digital cut.

• Perform a Send to Playout operation.

• Check in the sequence to Interplay for 
Pro Tools if the Pro Tools editor needs to 
work on the sequence again.

Frame-Rate Accurate Video Editing and 
Sample-Rate Accurate Audio Editing

After a sequence has been exported back to In-
terplay from Pro Tools, a number of additional 
media files appear in the Interplay Window and 
in the bin. Some have names containing the 
prefix Sample accurate edit. These are the addi-
tional media files that Pro Tools creates to make 
sure that the Avid application receives frame-ac-
curate audio. Sample-accurate edit media files 
are visible if you zoom in on portions of the im-
ported audio in the Timeline.

The following illustration shows Sample accu-
rate edit files in the Interplay Window.

Avid video editing applications edit with frame 
accuracy. This means that when using an Avid 
application to work on a 30-fps project, you can 
edit at 30 different locations for every one sec-
ond of video. Pro Tools edits with sample rate 
accuracy. In a 48 kHz session, there are poten-
tially 48,000 locations to edit for every second of 
audio. 

When Pro Tools exports a sequence, it must en-
sure that the audio media files line up on frame 
boundaries. To do this, it might have to split an 
existing audio region into three regions. For ex-
ample, the following illustration shows a 5-
frame video clip and a corresponding audio re-
gion. In Pro Tools, the audio regions might not 
line up on video frame boundaries.

Sequence in the Avid Timeline after overwrite

Sample-accurate edits in the Interplay window

The original audio clip does not line up on video frame 
boundaries

Sample-accurate 
edit audio files

1 Pro Tools
audio region

5 frame
video clip
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In order to export frame accurate audio regions, 
Pro Tools splits the audio media on frame 
boundaries and fills any gaps with silence. The 
following illustration shows the resulting audio 
regions that are exported to the Avid applica-
tion.

To cut down on the number of sample accurate 
edit files, the Pro Tools editor can perform a 
Bounce to disk for each track (or a bus-record to 
an audio track) rather than exporting tracks that 
contain all of the audio edits. 

Synchronizing Audio with an 
Avid Sequence
Once you have imported an audio file or se-
quence from Pro Tools into a bin in the Avid ap-
plication, you can synchronize it with video. 
This is especially useful for verifying sync with 
the original video sequence, then laying audio 
and video back to tape or creating a digital 
movie with your final mix.

To synchronize an edited audio file or sequence 
with the original video sequence:

1  Ensure that the audio exported from Pro Tools 
is now residing in a bin within your current 
project.

2  Drag the original sequence to the Record 
Monitor to see all elements in the Timeline.

The original sequence displays in the Timeline.

3  Drag the imported audio clip or sequence 
from the bin to the Source Monitor. New Source 
Track buttons for the source appear to the left of 
the Track buttons for the Timeline.

Exported audio regions line up on video frame 
boundaries

3 exported
audio regions

5 frame
video clip

New audio regions 
padded with silence

Record and Source Monitors

Original sequence displays in Timeline

New track buttons

Timeline
Track
buttons

Source
Track
buttons

Timeline
Track
buttons
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4  Use the controls underneath the Source Mon-
itor to locate the first frame of the portion of the 
clip that you want to edit into the sequence:

• To begin playing the clip, click Play (or 
press the Spacebar). Click Play or press the 
Spacebar again to Pause.

• To move to the beginning of the clip, click 
Rewind (or press the Home key).

• To move to the end of the clip, click Fast-
Forward (or press the End key).

• To nudge by frame, click Step Forward 1 
Frame or Step Backward 1 Frame (or press 
the Left/Right Arrow keys).

• To scrub, click and drag the cursor beneath 
the Source Monitor. (Enable the Caps Lock 
to hear audio while scrubbing.)

5  Click Mark In to mark the In point (the first 
frame of the selected portion) at the current po-
sition of the cursor.

6  Using the same controls, locate the last frame 
of the portion of the source that you want to 
edit into the sequence. 

7  Click Mark Out to mark the Out point (the last 
frame of the selected portion) at the current po-
sition of the cursor.

The portion of the audio source between the In 
point and the Out point is now selected for ed-
iting into the sequence.

8  Choose Clip > New Audio Track to add audio 
tracks to the sequence. (This leaves any original 
audio tracks in place to compare synchroniza-
tion.) Add a new track for each channel of audio 
you want to add.

Source Monitor controls

Enable the Caps Lock to hear audio while 
scrubbing.

Rewind

Fast-
Forward

Step Forward 1 
Frame

Cursor

Play/ 
Pause

Step Backward 1 
Frame

Mark 
Out

Mark 
In

Clear Both 
Marks

Mark 
Clip

You can also select the entire source clip or 
sequence by clicking Mark Clip.

You can also click the Clear Both Marks 
button to clear the In and Out points.

Audio tracks in the Timeline

Existing
audio
tracks

New audio
tracks
Pro Tools Unity ISIS Guide



9  If necessary, click on the Source track buttons 
and drag to the desired new Timeline track but-
tons so that the new media will be placed on the 
correct tracks in the Timeline.

10  If the original audio tracks still display yellow 
speaker icons, click the speaker icons in the 
Track Enable button to mute them. The speaker 
icons for the original tracks will disappear, and 
the speaker icons should appear yellow in the 
new tracks, indicating that they will be heard.

11  If the video track and the original audio 
tracks are enabled (gray), disable them and en-
able the new audio tracks (purple), by clicking 
the correct audio track buttons (A1–A24). This 
will ensure that only the new tracks will be af-
fected by any editing commands.

12  In the Timeline, place the cursor at the posi-
tion where you want to lay the new audio into 
the Timeline. (Press Home to move to the begin-
ning of the sequence.)

13  Under the Record Monitor, click the Clear 
Both Marks button to remove any In and Out 
points (if present).

Aligning Source audio tracks with Timeline audio tracks

Clicking the speaker icons to disable Source tracks

Source
Track linked
to Timeline
track

Linking
Source track
to Timeline
track

Speaker
icons

New audio tracks in Timeline

Timeline containing two empty audio tracks

Record Monitor controls

Enabled
tracks

Disabled
tracks

Clear Both
Marks
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14  Click the Overwrite button to lay the audio 
into the Timeline.

The audio selected between the In and Out 
points in the Source Monitor is laid into the 
Timeline at the position of the cursor.

15  If you want to display audio waveforms in 
the Timeline, click the Fast Menu (located on 
the lower left hand corner of the Timeline), and 
choose Audio Data > Energy Plot. Ensure that 
the new audio tracks appear synchronized with 
the originals.

16  If necessary, make sure the video track’s 
Monitor button is enabled (purple). This will al-
low you to view the video portion of the se-
quence in the Record Monitor (or client 
monitor).

17  Press the Home key to move the cursor to the 
beginning of the sequence and press the Space-
bar to play the sequence. The new audio should 
be synchronized with the video.

After verifying the new audio sequence is cor-
rectly synchronized, you can do either of the 
following:

• Lay audio and video back to tape using Dig-
ital Cut

• Export your sequence as a QuickTime, 
MPEG, or other format digital movie.

Overwrite and Splice-In buttons

Timeline with new audio sequence

Fast menu

OverwriteSplice-In

New audio tracks 
from Pro Tools

Fast menu

Enabling the Video track

Monitor
button
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appendix a

PCI and PCIe Slot Configurations for 
Pro Tools and Media Station|PT with Avid 
Unity ISIS Systems

This appendix covers PCI and PCIe slot configurations for Pro Tools|HD systems with Avid video pe-
ripherals on Windows. These slot configurations have been qualified and recommended by Digide-
sign.

Summary of Recommended Windows PCI and PCIe Slot 
Configurations
This section summarizes qualified and recommended PCI and PCIe slot configurations for the follow-
ing Windows machines with or without expansion chassis, for both local and shared storage:

• HP xw8400

• HP xw9300

HP xw8400

HP xw8400 with host cards (shared storage)

• Intel Pro/1000 MT Dual Port Server Adapter PCI host card to Unity ISIS

See “Shared Storage Slot Configuration for HP xw8400 with Intel Pro/1000 MT Dual Port Server 
Adapter PCI Host Card to Unity ISIS” on page 76.

HP xw8400 with expansion chassis (shared storage)

• Digidesign Expansion|HD PCI Chassis with PCI host card, using Intel Pro/1000 MT Dual Port Server 
Adapter PCI host card to Unity ISIS

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using Intel Pro/1000 MT Dual Port 
Server Adapter PCI host card to Unity ISIS

See “Shared Storage Configurations for HP xw8400 with Expansion Chassis” on page 77.
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HP xw9300

HP xw9300 with host cards (shared storage)

• Intel Pro/1000 MT Dual Port Server Adapter PCI host card to Unity ISIS

See “Shared Storage Slot Configurations for HP xw9300 with Host Cards Intel Pro/1000 MT Dual Port 
Server Adapter PCI Host Card to Unity ISIS” on page 79.

HP xw9300 with expansion chassis (shared storage)

• Digidesign Expansion|HD PCI Chassis, using Intel Pro/1000 MT Dual Port Server Adapter PCI card 
to 4 GB Unity MediaNetwork

See “Shared Storage Slot Configurations for HP xw9300 and Digidesign Expansion|HD Chassis with 
Intel Pro/1000 MT Dual Port Server Adapter PCI Host Card to Unity ISIS” on page 80.

HP xw8400 PCI and PCIe Slot Configurations
This section describes qualified and recommended PCI and PCIe slot configurations for HP xw8400.

Shared Storage Slot Configuration for HP xw8400 with Intel Pro/1000 
MT Dual Port Server Adapter PCI Host Card to Unity ISIS

The following table describes qualified and recommended PCI and PCIe slot configurations for an 
HP xw8400 system connected to shared storage via the Intel Pro/1000 MT Dual Port Server Adapter 
PCI host card:

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) HD Core card

CPU Slot 6 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 7 (100MHz PCI 64-bit) Intel Pro/1000 MT Dual Port Server Adapter PCI card
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Shared Storage Configurations for HP xw8400 with Expansion Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw8400 
systems, with the following expansion chassis and host cards connected to shared storage:

• Digidesign Expansion|HD PCI Chassis with PCI host card, using Intel Pro/1000 MT Dual Port Server 
Adapter PCI host card to Unity ISIS

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using Intel Pro/1000 MT Dual Port 
Server Adapter PCI host card to Unity ISIS 

HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCI Host Card:
Intel Pro/1000 MT Dual Port Server Adapter PCI Host Card to Unity ISIS

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) ATTO Celerity FC-41ES PCIe card

CPU Slot 5 (133MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Intel Pro/1000 MT Dual Port Server Adapter PCI card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCIe Host Card:
Intel Pro/1000 MT Dual Port Server Adapter PCI Host Card to Unity ISIS

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Digidesign Expansion|HD Host PCIe card

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) Untested

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Intel Pro/1000 MT Dual Port Server Adapter PCI card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw9300 PCI and PCIe Slot Configurations
This section describes qualified and recommended PCI and PCIe slot configurations for HP xw9300 
computers for use with Avid Unity ISIS systems.

Shared Storage Slot Configurations for HP xw9300 with Host Cards Intel 
Pro/1000 MT Dual Port Server Adapter PCI Host Card to Unity ISIS

This section describes the qualified and recommended PCI and PCIe slot configuration for an 
HP xw9300 system connected to shared storage via the Intel Pro/1000 MT Dual Port Server Adapter 
PCI host card.

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Untested

CPU Slot 4 (100MHz PCI 64-bit) Intel Pro/1000 MT Dual Port Server Adapter PCI card

CPU Slot 5 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 6 (133MHz PCI 64-bit) HD Core card
Appendix A: PCI and PCIe Slot Configurations for Pro Tools and Media Station|PT with Avid Unity ISIS Systems 79
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Shared Storage Slot Configurations for HP xw9300 and Digidesign 
Expansion|HD Chassis with Intel Pro/1000 MT Dual Port Server Adapter 
PCI Host Card to Unity ISIS

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw9300 
systems and the Digidesign Expansion|HD PCI Chassis, with the Intel Pro/1000 MT Dual Port Server 
Adapter PCI host card connected to shared storage.

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Untested

CPU Slot 4 (100MHz PCI 64-bit) Intel Pro/1000 MT Dual Port Server Adapter PCI card

CPU Slot 5 (100MHz PCI 64-bit) Untested

CPU Slot 6 (133MHz PCI 64-bit) Expansion|HD Host PCI Card

Chassis Slot 1 (closest to 
power supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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